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Niagara AX to N4 Migration Guide About this Guide

About this Guide

This topic contains important information about the purpose, content, context, and intended audience for this
document.

Product Documentation

This document is part of the Niagara technical documentation library. Released versions of Niagara software
include a complete collection of technical information that is provided in both online help and PDF format. The
information in this document is written primarily for Systems Integrators. To make the most of the information
in this book, readers should have some training or previous experience with Niagara software, as well as
experience working with JACE network controllers.

Document Content
This guide provides information about migration of EC-NetAX system running EC-NetAX-3.8 to Niagara 4
system running EC-Net 4 v4.0, and has the following main sections.

¢ Migration overview
Provides requirements, restrictions, compatibilities between EC-NetAX and Niagara 4, background on the
need for migration (including major differences), and a general migration workflow process.

e Migration tasks
Provides tasks to start migrating stations, including collecting EC-NetAX-3.8 station archives, running the
N4 migration tool, migrated database cleanup, preliminary EC-Net 4 station checkout, and installation of
Niagara 4 software and controller upgrades.

* System verification
Explains system areas that may need attention and possible configuration immediately following the
installation of Niagara 4 upgrades and migrated stations.

e Migration reference
Contains some details on Program object (component) changes in EC-Net 4 , along with an example
“Program object fix".

* Migrating Niagara Enterprise Security stations
Describes how to migrate your NiagaraAX-3.8 based security Supervisor and controller stations to
Niagara 4.8 based security stations.

e 4. Connecting from the Supervisor to the NiagaraAX-3.8 legacy security station

Describes how you can connect and join Niagara Enterprise Security 2.4 stations to Niagara Enterprise
Security 2.3 JACE-6 controllers.

Document change log
March 12, 2025
* Added new note in the "Creating and updating the HSQL database password" topic.

May 29, 2023

* Updated “Communications support between Niagara 4 and NiagaraAX" table in Wire Compatibility topic

* Added procedure for “N4 exisitng station” to the “Creating and updating the HSQL database password”
topic.

February 6, 2023
Added procedure for “N4 exisitng station” to the “Creating and updating the HSQL database password”
topic.

December 10, 2020

Rewrote the last sentence of “Connecting from the Supervisor to the NiagaraAX-3.8 legacy security station”
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topic.

November 2, 2020
Combined “Migration workflow diagram” topic with “Migration workflow process” topic and “Migration
workflow diagram” topic deleted from book map.

June 1, 2020

* Edited certificate descriptions and procedures.

* Confirmed upgrade procedures for Niagara Enterprise Security stations.
e Corrected variables used for document branding.

December 16, 2019
e Edited procedures for exporting certificate key information prior to migration.

* Removed procedure for configuring new Photo ID device in Chapter 5. This information is in the Niagara
Enterprise Security Installation and Maintenance Guide.

August 7, 2019
Edited procedures related to migrating Niagara Enterprise Security stations from NiagaraAX to N4.

April 19, 2019
Added two chapters related to station migration and legacy controller connections.

November 13, 2017
Removed a reference to tagged categories from the procedure, “Tips for Configuring oBIX Authentication”.

November 19, 2016
Removed text in “Driver and Application Support” topic indicating N4 support for video drivers.

May 6, 2016
One change was made in the topic, “File Locations”: in the table under the heading Homes in a Supervisor,
corrected the path for the protected_station_home

February 22, 2016

¢ Added information about setting the configuration flag before migrating users. Changes were made to
two topics:

* "Features and compatibility between N4 and AX,” and “Assess and prepare for N4 migration.”
* The following topic was added: “Configuring an AX station to migrate users”

¢ Edited the entire document to streamline the way software names are used and to convert task material
to task steps.

August 7, 2015

Initial release document.

Related documentation
Additional information about Niagara platforms, installation and operation Workbench is available in the
following documents.

* Niagara Platform Guide
e Getting Started with Niagara
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Chapter 1. Migration overview

The Niagara Framework® has evolved to the point where existing NiagaraAX platforms and stations, if
upgradable, must be migrated to Niagara 4. Therefore, after installing Workbench, you cannot simply use
stations saved in NiagaraAX.

Migration involves several concepts:

e Conversion of AX artifacts to the corresponding N4 format; for example, station .bog files, Px files. The
N4 migration tool handles this conversion.

e "“Wire compatibility” (communications) between AX and N4, with the possibility that some migrated jobs
must retain some number of AX controllers. Some platform types cannot be migrated, for example,
JACE-2 controllers.

* For platforms to be migrated that use custom AX software modules, the custom modules must be
refactored as N4-compatible modules.

Why a migration tool?

Niagara 4 has different platform and resource requirements than NiagaraAX, and there are other
considerations that affect the suitability for a job to migrate from AX to Niagara 4. An understanding of these
is essential before beginning migration work for any existing NiagaraAX job.

As a result of the fundamental changes and security improvements in Niagara 4, a migration process is
required. Simple reuse of any saved AX station is not possible. Following, are a few of the major reasons:

¢ Directory structure changes

In NiagaraAX, all folders and files are installed and created/maintained under a single Sys Home
directory. For example, for a Windows PC platform that directory is: C:\niagara\niagara-3.8.111. This
directory includes runtime files and executables (modules, JRE, bin) along with configuration data files
(stations, Workbench options and registry).

To improve security, these files and folders are relocated in Niagara 4. See Platform and station file
systems.
¢ Software modules were refactored

In NiagaraAX, each software module typically contains multiple content levels: “runtime”, “user interface”
(ui), and sometimes “doc”. When installing modules in JACE controllers that are unable to utilize all levels,
AX platform tools “filter” out unneeded content levels at install time. However, Niagara 4 uses the Java
Security Manager, which does not support this model. So, software modules in Niagara 4 were refactored,
essentially split into two or more separate modules JAR files that differ by runtime profile (-rt, -ux, -wb,

-se, -doc). This also simplifies future module updates.

The N4 migration tool addresses refactoring when converting an AX station. However, if you have stations
that use custom or third-party modules, those modules must be refactored the same way before starting a
migration.

e Users, Categories, and permissions were overhauled

A number of changes to a station’s UserService and child User components occurred in Niagara 4, which
provide easier ways to manage large groups of station users. Coupled with new “Role” components and
“Tagged Categories”, permissions management is more logical and flexible. A related new
AuthenticationService architecture allows the flexibility to specify the “authentication scheme” to use for
station access at the user level. Among other things, this lets you integrate LDAP users into a station’s
standard UserService, (no special LDAP or Active Directory user service required).

¢ Fox Service has moved

The FoxService component in Niagara 4 was relocated to each station’s main Services container, rather
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than existing as a frozen slot under the NiagaraNetwork component. Other related authentication
changes were made as well.

e Ports in QNX platforms are sometimes redirected

As part of increased security in Niagara 4, the station process in all JACE controllers runs as an
“unprivileged process”, where such processes cannot bind to TCP/UDP ports less than 1024. This affected
some services and network types operating as servers using standard ports in this range.

To accommodate this, a new “Server Port” component architecture is used, where client requests to the
standard privileged ports are automatically redirected to other (higher) unprivileged ports. Most notably,
the default HTTP and HTTPS ports of 80 and 443 for a station’s WebService are now automatically
redirected to ports 8080 and 8443. For related details, see “Server Port model” in the NiagaraAX
Platform Guide.

There are many other differences and numerous new features in Niagara 4, however ones like the above are
examples of “breaking changes” that require a database migration tool, and not just the simple addition of
new Java classes and methods.

Platform compatibility
The PC or host controller you wish to upgrade must meet hardware and software requirements.
To qualify as a candidate for migration, any of the supported platforms listed below should be running a

released version of NiagaraAX-3.8, with working communications to other platforms at the job site running the
same software version. Earlier versions are not supported for migration.

Host Model N4 supported / OS / notes N4 compatibility notes
Supervisor or Engineering Supported OS is Professional Windows Vista (all) and Windows XP (all) are
Workstation(”Workstation”) or Enterprise versions of unsupported. Linux OS support is unavailable. Prior

Windows 7, Windows 8.1, or editions of Windows Server, such as
Windows Server 2012 or Windows Server 2008, are unsupported.
Windows Server 2012 R2

(either 64-bit or 32-bit

editions of any of these).

JACE-8000 Supported Initially supports only N4. At some future
point, an update release of AX-3.8 may be
available that supports most features of this
newest controller.

JACE-7 (JVLN) Supported with Niagara 4.4 WiFi option is not supported. Some other
and earlier. option cards are also not supported in (see
NPM below).

JACE-6E, JACE-603, JACE-645 (NPM6E) Supported with Niagara 4.4 Unsupported options include: GPRS, Sedona
and earlier. wireless, and dialup modem. Minimum
resources are required (fully loaded units in
JACE-6, JACE-602 Express (NPM6E) N4 may not run in Niagara 4.0). For details,
refer to Platform resource requirements.

JACE-3E (NPM3E)
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Host Model N4 supported / OS / notes N4 compatibility notes

JACE-2, JACE-202 Express (NPM2) Not supported Support is available for data exchange with
N4 platforms. For example, these stations

JACE-403 can be under the NiagaraNetwork of N4

JACE-545 Supervisor. For related details, see Features
and compatibility .

JACE-NXT

JACE-NXS

SoftJACE

Supported Support is available for data exchange.

If you first upgrade a system to AX in preparation for migration to N4, be sure to verify proper operation of
the system (including NiagaraNetwork communications between stations), before making station backups to
use in the migration process.

Niagara 4 platform compatibility

For any supported PC or host to be migrated, be sure it has the necessary resources available. See Platform
resource requirements.

Platform resource requirements

N4 requires more disk space, more Java heap, and more system RAM to run than a similar AX station.
Therefore, AX-3.8 JACE running near capacity will probably not fit the same station when converted to N4. A
brief summary of reasons why are as follows.

* Disk space (Flash)
N4 requires between 14-16 MB more space than an equivalent AX installation. Additional space is
required by the new Java 8 VM (vs. Java 5), and new UX features enabling a rich browser experience.
¢ Heap space
For an equivalent station, N4 requires more Java heap (a baseline of 10MB) due to new features and
functionality, and more system memory when running on JACE controller.
e History RAM disk size (NPM6/NPM6E only)

To free additional system memory, the maximum history RAM disk size on JACE-6 has been reduced from
64MB to 32MB. This should not affect most units because the default RAM disk size is 32MB. If the RAM
disk on JACE-6 has been increased, then this increase in the RAM disk size comes at the expense of Java
heap. Maximum history count has not changed.

Recommended minimum resources by controller type

Each platform you migrate requires a minimum of resources in preparation to run the new system.

The following table summarizes recommended resource requirements before converting to N4.

T F Minimum Frec;
inimum Free H in MB(i

1 e Java M eap, in

|\D/|I§k Space, in Ha::p’ iixMB maxHeap feature

licensed(1) )

JACE type/
model

NPM3
(JACE-3E)
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. Minimum Free
JACE type/ Minimum Free )., Max Heap, in MB(if

model mék Space, in Heap, in MB  maxHeap feature
licensed(1) )

NPMé6
(JACE-6)

NMP6E ( 24
JACE-603,
JACE-645)

JACE-7 22

(1) If an
JACE is
NOT
currently
licensed
with the
"maxHeap”
feature,
then heap
usage will
not be an
issue in N4.

The Minimum Free Disk Space recommendation is based on the following:

e 4MB free reserve for future N4 expansion

e AMB for Data Recovery (NPM3E and NPMéE)

* 14MB for N4 increase

e 2MB for JACE-6 boot partition increase

The Minimum Free Heap recommendation is based on the following:

(20% total 86 NB heap size = 17MB) + (13MB additional <span class="keyword">N4span> overhead + 8 MB
smaller heap (J3/J6 only) = 38 MB

Checking for minimum resource requirements

There is a special BOG file with the AX-compatible Program component that you can use to determine if a
platform meets the minimum resource requirements for migration. Test results are provided for free disk space,
free heap memory, and ram disk size.

12 March 12, 2025



Niagara AX to N4 Migration Guide

Figure 1. Example resources check notification using the Program in AX-3.8 JACE station
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Migration overview

Alternatively, you can manually check resources, and compare to the recommended resource minimums given

in Table 2 on page 7.

Using the resource checker Program

This program provides a binary result: Failed or Passed. Only hosts that pass can be migrated.

Prerequisites:

You have the BOG file with the resource checker program, Workbench, and can open a station connection (Fox
or Foxs) to the host controller.

Step 1. Copy the BOG file with the resource checker program component to your AX-3.8 system home

folder.

Step 2. Using Workbench, open the station (Fox or Foxs), and expand Config to find a folder to copy the
Program into, or else add a new folder. You can locate it anywhere under Config.

Step 3. Inthe Nav tree, locate the BOG file with the resource checker program (it may be named
“N4UpgradeResourceCheckerV1_n") and copy it into the station. You should be able to
immediately use the program.

Step 4. Right-click the program in the station, and select Actions > > Execute.

After a few seconds, a popup AX to N4 Upgrade Resource Checker window opens with the test
results, as either “Passed” or “Failed”.

Step 5. Click OK to close the window.

Manually checking for free disk space

A minimum amount of free disk space is required.

Prerequisites:

March 12, 2025
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The host platform is at AX-3.8 and running the station to be migrated.
Step 1. Using Workbench, open the station (Fox/Foxs)..

Step 2. Expand Config > Services and double-click PlatformServices.
The Platform Service Container Plugin view opens.

Step 3. In the Filesystem entry for /ffsO, compare the Free value with the value in Recommended
minimum resources by controller type.The JACE value should be equal or greater than this

minimum value.

Manually checking heap usage

A minimum amount of Java heap is required.

Prerequisites:
The host platform is at AX-3.8 and running the station to be migrated.

Step 1. Using Workbench, open the station (Fox/Foxs), and access the Spy page (in Nav tree, right-click
Station node and select Spy).

Step 2. Click util > gc

Step 3. Refresh the page several times, observing the usedMemory value under the After GC heading.

Remote Station | util | gc

Force Garbage Collection
Before GC
totalMemory 24320kb
freeMemory 2500kb
usedMemory 21820kb
After GC
totalMemory 24320kb
freeMemory 3139kb
usedMemory 21181kb
Freed

freed 639kb

Result

This represents the low point of Java heap usage.

Driver and application support

The initial release of Niagara 4 supports most of the commonly used NiagaraAX drivers, including BACnet,
LonWorks, Modbus, SNMP, and some legacy serial-based drivers. Support was dropped for a few drivers.

The following table lists a few drivers and applications that are no longer supported.
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Unsupported driver / application

Migration overview

Removed modules / notes

802.1x wired authentication support

for QNX-based JACE controllers

OpenADR client drivers (simple,
smart)

Alarms to relational database
support

Original crypto/security module,
using “CryptoService” in station

Dust wireless mesh network

Energy Application System (EAS),
also known by the branded name
VES

Support for FIPS 140-2 (Federal
Information Processing Standard)

Floating license repository

Fox tunneling, HTTP tunneling, and

platform tunneling

IBM DB2 relational database support

Lon tunneling

Sedona (SedonaNetwork,
SedonaJenélpNetwork)

Older video drivers based on the

March 12, 2025

Module “platlEEE8021X"

Modules “adr” and “dras”

Module “alarmRdb"”. Superseded by module “alarmOrion”.Note if a
third-party application accesses alarms, it will be affected by this
(change in the exported schema).

Module “crypto”—replaced by “platCrypto” since AX-3.7 (should only
be used by non-Hotspot JACEs, for example,. JACE-2).

Module “dust”

Module "“eas”

Special FIPS distribution (.dist) file

Module “flr”

Improved security in N4 prohibits most tunneling. Only serial tunneling
is supported in Niagara 4, via the “tunnel” module on the station (server)
side and a separate client-side tunnel application.

Module “rdbDb2"”

Module “lontunnel”. Improved security in N4 prohibits this tunneling.

Module “sedonalnstaller” in Ax builds, which, from a downloaded
Sedona “bundle,” would install Sedona-specific modules for
integration. These are not supported.

"on

Modules “video” (base), "axis”, “dedicatedMicros”, "milestone”, and

15
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Unsupported driver / application Removed modules / notes

"devDriver”, superseded in AX by “rapideye”, superseded in AX by modules “nvideo”, “naxisVideo”,
"nDriver” based videoDriver “ndedicatedMicros”, “nmilestone”, and “nrapideye”.
framework

Platform support forNiagara R2 on any Niagara R2 platform support on JACE-603/JACE-645 controllers requires
QNX-based JACE controller Workbench (3.6, 3.7, or 3.8).

NOTE: This is a partial list. Other rarely-used or limited-distribution software modules were not brought
forward to the new version. For more information, check with your support channel to verify availability.

Additionally, any OEM-specific or custom (non-Tridium) software modules used on any platform to be migrated
must be refactored for use in Niagara 4. This is a separate process from using the migration tool on a saved AX
station, and must be completed by the custom module developer before you migrate the station.

Wire compatibility
Supported communications, or “wire compatibility” between platforms and tools can be a factor in different
job scenarios. Version compatibility is also relevant when it comes to feature support between N4 and AX. The

following sections describe compatibility between the two major versions of Niagara with regard to
communications and features.

Supported connections
Workbench can connect to stations running NiagaraAX as well as stations running Niagara 4. The following
table summarizes the possible connections and indicates which are supported in Niagara 4.

Table 1. Communications support between Niagara 4 and NiagaraAX

From To Supported Notes
AX Workbench N4 station, N4 No Prohibited in software.
Supervisor
AX Workbench N4 platform No Prohibited in software.
N4 Workbench AX platform Yes Provides support necessary for AX to N4 upgrades. A few

functions from the EC-NetAX Pro remote controller Platform
Administration view are unavailable, including the
Commissioning Wizard function.

AX Workbench AX station Yes Supported in software.AX Workbench is required to configure
AX station.
AX station N4 station, N4 Yes Discovery of points, schedules, and histories in N4 stations is
Supervisor unavailable. However, you can manually add points. Refer to

the following section (Features and compatibility) for
more details.

N4 station, N4 Supervisor AX station Yes Refer to the following section (Features and
compatibility) for more details.

N4 station AX Supervisor No Not prohibited in software, but unsupported.

Features and compatibility
A limited number of features are supported when communicating between Niagara 4 and AX-3.8.

This table indicates which features are supported when communicating between stations.

16 March 12, 2025



Niagara AX to N4 Migration Guide

Table 2. Feature compatibility table

Feature

Point discovery
Point data

Export Histories
Import Histories

Alarms routed to and
acknowledged

Export Schedules
Import Schedules

Synchronize users out (sync out)

Synchronize users in (sync in)

Virtual points

Tunneling

Export tags

File transfer using Fox
(NiagartaDeviceFileExt) is
supported.

Provisioning

From N4 to AX From AX to N4

No (AX Supervisor) Yes (N4
Supervisor)

Yes Yes
No Yes
No Yes
No Yes
Yes No
Yes No
Yes, but only users No

AXis capable of

supporting

No Yes, but only users
AX is capable of
supporting

Yes Yes

n/a n/a

No, stations cannot Yes, stations can
join as join as
subordinates subordinates

Yes Yes

Yes

Migration overview

Additional comments

AX stations cannot discover points in N4 stations. The
alternative is to manually add and configure the points.

N4 supports virtual points in AX stations. AX supports virtual
points in N4 stations.

N4 uses different history encoding, and so detects and
converts history records as they come in.

Supported users are those assigned an authentication
scheme with a password that can be ported to the AX
station. The synchronization process is supported in only one
direction.

LDAP is a good alternative for network user
synchronization.

Although AX stations do not support the HTML5
user prototype, you can synchronize users
configured with the HTMLS5 user prototype to AX
stations by enabling the user Defined 1
configuration flag on the web WebProfileConfig
property of the user prototype slot in the AX
station.

As Fox, HTTP, and platform communications provide
insufficient security, they are not supported in N4. Serial
tunneling is supported.

For the AX station (subordinate) to join an N4 station
(Supervisor), prior to executing the export tag join, the two-
way Fox connection in each station’s NiagaraNetwork must
be established between the stations. Failure to preconfigure
the two-way connection results in an error during the export
tag join.

Using Px files with ExportTags may be
problematic as all Px files must be converted for
use with N4.

File permission checks are enforced.

Supported operations for AX subordinates include:
* Update licenses

* Backup stations

* Copy Supervisor file

* Install valid AX software

* Upgrade out-of-date AX software

* Restore prior station backup, for example,
from the step history view of a backup job.

N4 provisioning robots will not run on Ax

March 12, 2025
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Feature From N4 to AX From AX to N4 Additional comments

stations.

NOTE: For Niagara 4 Supervisor to provision AX stations in addition to its own stations, you must import the
software database from the prior Supervisor into the new Supervisor’s software database. However, Niagara 4
Supervisor cannot directly upgrade platforms to Niagara 4.

Platform and station file systems

During installation and platform commissioning, the software differentiates between two types of files and
stores them in separate locations (homes) based upon the content of the files: configuration and runtime data.

Configuration data, which can by changed by users, include stations, templates, registry, logs, and other data.
Runtime data include core software modules, the JRE, and binary executables. Maintaining separate file
locations enhances security by denying general access to runtime files (runtime folders are read-only) and
allowing each user access to only their personal configuration files.

Multiple home directories serve to separate configuration and runtime data. Each platform has a User Home
for configuration data and a System Home (Sys Home) for runtime data. Several other folders under these
homes serve specific functions.

The platform’s System Home (Sys Home) is sometimes identified by its alias, niagara_home. It has a security
subfolder that contains license files and license certificates. Except when it is time to upgrade, the System
Home's runtime files are read-only.

The platform’s User Homes contain all configurable data. Referred to by the alias niagara_user_home, the
separation of these files from the runtime files stored in the System Home folder is new in Niagara 4. The
impact of this change is mostly felt when manipulating stations. When Workbench creates a new station, it puts
the station in the platform’s User Home directory. To start Niagara, the station must be copied from the station
User Home to the platform’s daemon User Home.

Due to application differences, there are some minor differences between the complete list of files in a user’s
User Home and the daemon’s User Home. For instance, daemon.properties only exists in the daemon'’s
User Home and navTree.xml only exists in the logged in user’s User Home.

Controller homes

A controller has one System Home and one User Home. The System Home on a controller appears as System
Home in the Platform Administration view.
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Figure 2. Controller System Home (niagara_home ) and User Home (niagara_user_home) locations

172.31.66.17 (newSuper2) . Platfarm / Platform Administration -
- Nav Platform Administration
Baja Version Tridium 4.7.109.14
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& Platform 4 Change HTTP Port
- " HTTP Port 3011
@AppllcatlonDl Ector 5 . |
© certificate Maragement %) Change TLS Settin Daemon HTTPS Port 5011
@ Distribution File Installer @ Change Datef'l'"e | Host ID Qni-TITAN-TESS-A1CT-CCAB-EBFO
® rile Transfer cllent - Model TITAN
) Lexicon Installdr o Advanced gftions | Product JACE-3000
@ License Managgr ? Change O ut Settings | Local Date 13-Now-18
o Platform Admifistration - — | Local Time 8:19 Coordinated Universal Time
iew Ddemon Outpu
O software Mangger Local Time Zone uTC (=0)
e Station Copier ew System Log | Operating System gnx-jace-nd-titan-am335x-hs (4.7.108.14)
6 TCR/IP Configlration Y Coyifigure Runtime Profiles | Niagara Runtime nre-core-gnx-armle-v7 (4.7.109.14)
7 WiFi Configurafion Architecture armle-v7
i Confi NRE M |
a Remole GileSypiem _rels L Enabled Runtime Profiles rt,uxwb
H SysHome [Read Only)
0 bin 9 Backup | Java Virtual Machine oracle-jre-compact3-gnx-arm (Oracle Corporation 1.8,
Ni Stati Enabled bled
0 defaults K e — | iagara Stations Ena ena
O et ber of CPUs 1
0 jre o Reboot | Current CPU Usage 3%
lib Overall CPU Usage 2%
modules
— Filesystem Total Free Files Max File|
: UserHome (Read Only) ! 3,492,848 KB 3,254,342 KB 485 10915
0 daemon /mnt/aram0 393,215KE 393,043KB 0
0 /mnt/ram0 8,192 KB 8,131KB o
etc
Physical RAM Total Free
O logeing 1,048,576 KB 72,272 KB
O registry Other Parts hsm-eccS08 (Tridium 0.1.50)
O security né-titan-am335x-h= (4,1.0)

1. Identifies a controller’'s System Home (alias: niagara_home) in both the Nav tree and the Platform
Administration view. In the Nav tree, you find the controller’s System Home by expanding Platform >
Remote File System. The actual location of the System Home folder for a controller is: /opt/niagara.

2. ldentifies the controller's User Home or daemon User Home (alias: niagara_user_home) that contains the
installed and running station and other configuration files. The actual folder for the daemon User Home is:
/home/niagara.

Home in the
Platform

Home in the

Platform = q Niagara 4 alias OFD location and contents File ORD shortcut
Administration view Administration

view
Platform > Remote System Home niagara_home /opt/niagara I(asin
File System > Sys . . Niagarad.x)
Home (Read Only) Contains operating system data.
Platform > Remote User Home niagara_user_home /home/niagaraContains configuration data and ~ (unique to

the installed and running station. Niagara 4)

File System > User
Home (Read Only)

Supervisor homes
The homes on a Supervisor or engineering workstation support supervisory functions.
Supervisor homes include:

* A Sys Home, which contains runtime files, such as core software modules, the JRE, and binary
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executables.

* A User Home for each user. These are known as Workbench User Homes. They contain station
configuration data, including option files, and registries.

* A platform daemon User Home, which contains the Supervisor station and platform configuration data.

* Two station homes: a Protected Station Home and a Station Home. These are located on the computer’s
drive C.

Figure 3. Example Sys Home (niagara_home) on a Supervisor platform

My Host: IEGTDTGODRFD2.global.ds.honeywell.com (Station_practice) . Platform / Platform Administration
- Nav %  Platform Administration
Baja Versi Tridi 4.7.108.14
¥ O &) My Network # View Details | 21a Yerston refum
- D Version 4,7.108.14
My Fi sty L] ok
e @ Update Authentication | ISystem Home C:"\Niagara"\hliagara—4.?.10’9.14I
H SysHome =
0 bin n
Q cleanDist
D conversion “— S » ThisPC » IOSDisk (C) » Miagara * Miagara-4.7.109.14 v O Search Miagara-4.7.10¢
° defaults =
s O0SDisk (T ~ Mame Date modified Type
° docs N
Intel . e e
O etc ) bin 10/12/2018 11:20...  File folder
O javadoc Niagara cleanDist 10/12/2018 11:20...  File folder
Oie New folder conversion 10/12/2018 11:20...  File folder
0 - Niagara_4_Developer-4.7.109.14.2 defaults 11/13/201811:03 ... File folder
exicon
0 - Niagara-4.4.69.0 docs 10/12/2018 11:20 ... File folder
i .
Miagara-4.7.109.0 ete 10/12/2018 11:20 ... File folder
©Q modules javadoc 10/12/2018 11:20 File folder
O seau Niagara-4.7.109.14 ! e e
EERI) . jre 10/12/2018 11:20...  File folder
in
Q = lexicon 11/5/2018 10 M File folder
[ paemon UserHome.lnk cleanDist lib 10/12/201811:20 .. File folder
[ licenses.lar conversion rmodules 10/12/2018 11:20 ... File folder
D Workbench UzerHome.lnk defaults security 10/M12/2018 11:21...  File folder
D UserHome docs W 28 1:58PM  File folder
a C: ete
Q B2 javadoc
Q Z jre
0 My Modules lexicon
n@ My Tools lib
& Platform modules

The example above shows the file system for Niagara 4 Supervisor running on a Windows PC. In the example,
the actual location of the System Home folder on this PC is:

C:\niagara\niagara-4.7.109.14.

The following table provides a summary of the Supervisor or engineering workstation homes with shortcut
information.

Homein Home in the
the Platform
Workbench Administration
Nav tree  view

File ORD
shortcut

Niagara 4 alias Windows folder location and contents

My Host > System Home niagara_home C:\niagara\niagara-<4.x.xx> I'(asin
Niagarad.x)
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Home in  Home in the
the Platform
Workbench Administration
Nav tree view

My File

System >

Sys Home

My Host > N/A
My File

System >

User Home

N/A

shared

folder

stations N/A
folder

N/A User Home

Niagara 4 alias

niagara_user_home

station_home

protected_station_home

niagara_user_home

Migration overview

File ORD

Windows folder location and contents shortcut

where <1.x.xx> is the software version that contains
executable and software files.

C:\Users\<username>\N4-<4.x.xx>\tridium ~ (unique to

Niagara 4)
where:

<username> iS your name to identify you as the user of
your computer.

<4.x.xx> is a software version.

The Workbench User Home for each human user contains
that user’s unique configuration files.

A (as in
Niagarad.x)

C:\Users\<username>\N4-<4.x>\tridium\shared
where:

<username> is your name to identify you as the user of
your computer.

<4.x.xx> is a software version.

C:\ProgramData\N4-<4.x>\tridium\stations\<stationName> A/ (unique to
Niagara 4)

~ (unique to
Niagara 4)

C:\ProgramData\Niagara4.x\<brand>

Platform daemon user home (hon-human user) holds
platform daemon configuration files. Requires a local
platform connection to view in the Platform Administration
view.

Controller homes

A controller has one System Home and one User Home. The System Home on a controller appears as System
Home in the Platform Administration view.

March 12, 2025
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Figure 4. Controller System Home (niagara_home ) and User Home (niagara_user_home) locations
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e Station Copier ew System Log | Operating System gnx-jace-nd-titan-am335x-hs (4.7.108.14)
6 TCP/IP Configdration Y Coyifigure Runtime Profiles | Niagara Runtime nre-core-grx-armle-v7 (4.7.109.14)
7 WiFi Configurafion Architecture armle-w7
g};\wte ) ‘temd m ST E oy | Enabled Runtime Profiles rt,uxwb
%Hboi:le reseen] / “1) Backup | Java Virtual Machine oracle-jre-compact3-qnx-arm (Oracle Corporation 1.8,
0 defaults \ T | Niagara Stations Enabled enabled
0 etc ber of CPUs 1
0 jre o Reboot | Current CPU Usage 3%
8 iz dul Overall CPU Usage 2%
;‘:u: N Filesystem Total Free  Files Max File|
Tlem ! 3,492,848 KB 3,254,942 KB 495 10915
0 aeman /mntfaram0 333215KB 393,043KB o
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0 =t Physical RAM Total Free
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1. Identifies a controller’'s System Home (alias: niagara_home) in both the Nav tree and the Platform
Administration view. In the Nav tree, you find the controller’s System Home by expanding Platform >
Remote File System. The actual location of the System Home folder for a controller is: /opt/niagara.

2. ldentifies the controller's User Home or daemon User Home (alias: niagara_user_home) that contains the
installed and running station and other configuration files. The actual folder for the daemon User Home is:
/home/niagara.

Home in the

Home in the

Platform Tg:rfnm:lration Niagara 4 alias OFD location and contents File ORD shortcut
Administration view .

view
Platform > Remote System Home niagara_home /opt/niagara I(asin
File System > Sys . . Niagarad.x)
Home (Read Only) Contains operating system data.
Platform > Remote User Home niagara_user_home /home/niagaraContains configuration data and ~ (unique to

the installed and running station. Niagara 4)

File System > User
Home (Read Only)
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Windows user homes

For security reasons, each person that is a user of a Windows platform, has their own user home. This means
that each Supervisor platform has at least two user home locations: Workbench User Home (for people), and a
platform daemon User Home (for the daemon server processes).

The Supervisor engineering workstation that is licensed to run a station has a daemon User Home. The daemon
is a server process and represents a (non-human) user that manages the Supervisor’s running station. The
Supervisor's daemon User Home contains daemon-specific configuration information. The actual location of the
Supervisor's daemon user home is C: \ProgramData\Niagara4.x\<brand>. The platform daemon is
installed to this location and started from this location as a Windows service.

In Niagara, the installation wizard provides the default daemon User Home location, which you can change if
you wish. In the step to select the daemon User Home location you have the option to either accept the
default location or specify an a different location.

CAUTION: The daemon and Workbench User Homes are intended to be installed in distinctly separate
locations. This separation of homes is for security reasons but it also prevents certain unintended results. For
example, when the two homes are installed in the same location the Station Copier becomes unavailable, and
you will not be able to make a portable copy of the station.

In addition to this daemon User Home, a Windows host has a separate Workbench User Home for each person
(operator, administrator) who logs in with credentials to a Windows-based platform licensed for Workbench,
meaning a Supervisor or engineering workstation. Any given PC or workstation has at least one, and may
contain multiple Workbench User Homes.

Each person’s Workbench User Home is available in the Nav tree as a node under My Host > My File System
and contains unique configuration information that is not shared. This is where to find any new Workbench
station, as well as any remote station backups, templates and other configuration files. The actual location of
each person'’s User Home is in the Niagara4 . x folder under your Windows User account.

To see both types of User Homes on the same view, open a local platform connection to your Supervisor PC,
expand My File System in the Nav tree, and double-click on the Platform Administration view.

Figure 5. Local platform connection to a Supervisor station with Workbench and daemon User Homes

P

= Nav uY  Platform Administration
Baja Version Tridium 4.7.109.14
|-_=© O @ My Network _l‘ View Details !
Daemon Version 4.7.108.14
. . . .
@ My Host: IE6TDTGODRFD2.global.ds.honeywell.com (Station_g R i e T System Home C:\Niagara\Niagara-4.7.109.14
Q~ System Passphrase | | User Home C:\ProgramData\Miagara4. 7\tridium

@ 0 My File System
: Host My Host : IEGTDTGODRFDZ.global.ds.t
A sysHome Change HTTP Port . i _
Daemon HTTP Port 3011 (disabled in TLS settings)
E] Change TLS Settings | Daemon HTTPS Port 5011

Qc
WwWin- ) — —
e . Change Date/Time Host 1D Win-81A38-ED20-1AT3-FASD
' Model Workstation
e z T EEERE IR | Product Waorkstation
O vy modules View Daemon Output | Local Date 13-Mov-18
&% My Tools Local Time 14:38 India Standard Time
Configure Runtime Profiles
& Platform Local Time Zone Asia/Calcutta (+5:30)

- - |

1. Identifies the Workbench User Home.
2. ldentifies the daemon User Home.
When you first install Niagara 4 on your PC and start the daemon (by choosing the install option Install and
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Start Platform Daemon on installation), the installation program creates this daemon User Home
(Niagara4.O folder). Initially, it contains an empty stations sub-folder, until you copy a station to it.

Figure 6. Example of a daemon User Home location in Windows Explorer

« v P » ThisPC » OSDisk(C:) »|ProgramData * Miagarad.7 »|tndium ~ & Search trnidium 2
v e 0SDisk (C) < — ~ Name - Date medified Type
- daemon 11/13/2018 10:57 File folder
_bacnet etc File folder
Program Files logging File folder
Program Files (x86) registry File folder
W ProgramData —"— security File folder
Microsoft Onelrive shared File folder
stations 11/13/2018 10: File folder
MysaL W 11/13/201810:03 ... File folder
Mexthink
Miagarad.4
Miagarad.7 <]:I
tridiurm
daemon
etc
logging
registry
security
shared
stations
S

You can do this station copy in different ways. In Niagara 4, you can let the New Station wizard initiate this
copy from its last Finish step. Or, as needed, you can manually open a local platform connection and use the
Station Copier.

The actual location of each user’s home folder is under that user’s personal Windows account. Some example
Workbench user home locations are:

C:\Users\John\Niagara4.x\<brand>
C:\Users\Mike\Niagara4.x\<brand>

where “John” and “Mike" are separate Windows user accounts. The first time a Windows user starts
Workbench, the system automatically creates that user’s unique User Home folder.

The person that installs Niagara 4 on a PC acquires the first such User Home. If no other Windows users log on
to that PC, this may be the only Workbench User Home on the platform. However, if another person logs on to

Windows on that computer and starts Workbench, that user also acquires their own Workbench User Home.

The following figure shows an example Workbench user home location in Windows Explorer.
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Figure 7. Example of an automatically-created Workbench User Home in Windows Explorer

l Ch\UserstJohn Miagarad 0" Acme
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stations
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W

Station homes

Niagara 4 uses the Java Security Manager to protect against malicious actors who may attempt to access
station or platform data and APIs. The Security Manager uses signed policy files that specify the permissions to
be granted for access to code from various sources. Included are tighter controls about which applications
have access to parts of the file system. Two folders under the Workbench User Home serve to protect sensitive
data while allowing authorized access to data that can be shared.

e The stations sub-folder, otherwise known as the Protected Station Home (alias:
protected_station_home) contains the running station’s file system, and may be accessed only by core
Niagara software modules. Station items that are always in Protected Station Home, that is, items that are
not under the shared sub-folder include the following folders, as applicable:

® alarm

® history

® niagaraDriver nVirtual
® provisioningNiagara

® dataRecovery

All files in the stations folder root (config.bog, config.backup.timestamp.bog, etc.) are always in the
Protected Station Home. For this reason, in Niagara 4 it is no longer necessary to blacklist or whitelist
station files or folders.

® The shared sub-folder, otherwise known as the Station Home (alias: station_home), allows all modules to
have read, write, and delete permissions.

The alias station_home retains the same file ORD shortcut (*) as used in NiagaraAX—only in Niagara 4 it
points to the station’s shared sub-folder.

March 12, 2025 25



Migration overview Niagara AX to N4 Migration Guide

Figure 8. Example NiagaraAX station file folders compared to Niagara 4 station file folders

AX station folder N4 station folder

4 || stations a stations
4 | demo 3 demo
. alarm 4 demoToM4
| dev alarm
» . frames ; history
» . history niagaraDriver_nVirtual
» 0 html 4 | shared
| httpd | dev
, images » L frames
| naw » L. html
. niagaralriver_nVirtual | httpd
. public | images
> P , nav
| secure | public
J tree e px
» 0 demoToM4 | secure
| tree

As shown in the figures above, comparing an AX station file folder structure (left side) to the same station
migrated to Niagara 4, a number of folders are under this shared sub-folder. Included are folders and files
used in graphical (Px) views or navigation, such as images, px, nav and so on. Modules that are prevented from
writing to the station root by the Security Manager must write to the shared sub-folder.
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Figure 9. File ORD for the Station Home in Niagara 4 now points to the shared folder
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A 5y=Home PxFile.px  PxFile 1KB 25-Oct-18 2:34 PM IST

O User Home
g C
1!3!1 =
Q Z:
0 My Modules

u':' My Tools

& Platform
# Station (Station_practice)
._. Alarm
e Config
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Q px
Graphic.px
PxFile.px
@ Hierarchy
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As shown in a station running above, the Station Home (alias: station_home) file ORD (") now points to the
contents of the shared sub-folder. Other items in protected Station Home are no longer accessible or visible.

Copying a new station to the daemon user home

In Niagara 4, the New Station Wizard finishes with an option to copy the station from the station home (the
location for each new station) under your Workbench User Home to the User Home of the local platform
daemon.

Prerequisites:
The new station exists in the station home (under User Home).

Step 1. When the New Station Wizard prompts you with the option to Copy station, select the option
and click Finish.

Step 2. Make a local platform connection and log on.
The Station Copier transfers the station and prompts you with the options to start the station
after copying and enabling auto-start.

Step 3. Select the option to start the station.
The Application Director opens with the new station present in the daemon User Home.
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Result

The new station now exists in two locations on your local host: the original location in your Workbench User
Home, and also in the platform daemon User Home.

Once the station is running in the daemon User Home, you can make a backup of the running station, where
the backup .dist file goes in the backups folder of your Workbench User Home. Or, you can use the platform
Station Copier to copy the station back to the stations folder of your Workbench User Home.

NOTE: Using the Station Copier to copy the station back to your Workbench User Home is highly
recommended if you made any changes to the station. This is essential if you are installing it (copying it) to any
remote platform. Remember, the copy of the station in your Workbench User Home is immediately obsolete as
soon as you make changes to the copy of the station running in the daemon User Home.

Running a station from the Workbench User Home

Instead of running a station out of the daemon User Home, you can run a station directly from your Workbench
User Home (outside of normal platform daemon control).

You do this using the Niagara console command:
station stationName

This is not a recommended way to run a production station, but instead more of a developer utility that allows
quick access to station debug messages in the console window. If you run the station this way, be mindful of
possible port conflicts with any other station that the daemon user may be running locally (in daemon User
Home), meaning Fox ports, Web ports, and so on.

Shared file strategy

A sharing strategy makes it possible for multiple users of a single Supervisor or engineering workstation to
share station files including backups. This type of sharing is different from the shared station sub-folder. This
is a folder you create for the purpose of sharing backups and distribution files.

If multiple people log in (differently) to Windows on a Niagara 4 host and use Workbench, each person has
their own separate Workbench User Home.

Windows users require permissions to access other users’ files; yet it's possible that different users of a system
(Supervisor or engineering workstation) may need to share items, such as station backups, station copies,
saved template files, and so on. Such items may be in multiple Workbench User Home locations in Niagara 4.

Therefore, in some scenarios you may need to establish a sharing strategy, perhaps re-copying such items to a
commonly-accessible folder location on the Niagara 4 Windows PC. For example, you might create a shared
folder under the Niagara 4 System Home location (the Workbench User Home is not shareable).

Migration workflow process

Based on an existing NiagaraAX job with a Supervisor and some number of JACE controllers, the workflow
process for migration to Niagara 4 may look similar to below:

Migration workflow diagram
Basic steps in migrating your NiagaraAX installation are included in the following diagram.
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Figure 10. Migration steps diagram
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Red items indicate NiagaraAX artifacts. Blue items indicate Niagara 4 artifacts. Green boxes indicate steps you
need to take in the migration process.

Environment files are shown in yellow, because they may be generic to all versions of Niagara. If so, and
changed from defaults, they may require individual attention to see if values in them should be re-applied.
Examples of such files include modified !1ib/units.xml or !1ib/colorCoding.properties.

More detailed migration steps are included in the section Migration workflow process.

March 12, 2025 29



Migration overview Niagara AX to N4 Migration Guide

Assess and prepare for migration
This topic summarizes platform and station-related tasks to complete before migrating.

1. ldentify those platforms to be migrated. JACE controllers must be running at least NiagaraAX 3.8.nn, and
be compatible with N4.0. See Platform compatibility and Platform resource requirements for details.

2. Review the current drivers and applications running on the JACE controllers to be converted. See Driver
and application support for details.

If any drivers or applications are unsupported in N4.0, but are critical to retain, you can opt to leave those
controllers running AX-3.8, and still integrate them with Niagara 4 Supervisor station. However, you
cannot integrate a Supervisor at AX-3.8 with Niagara 4 JACE controllers.

NOTE: For any job that will have a mix of Niagara 4 and AX-3.8 platforms, refer to the section Wire
compatibility.
3. For each AX-3.8 platform to be migrated, identify custom or third-party software modules that it uses.

Prior to upgrading, arrange to have those modules refactored as Niagara 4 modules. Contact the custom
module vendor to arrange this.

NOTE:
You cannot migrate a station to N4 until all of the modules it uses have been refactored for Niagara 4.

If you are unsure if an controller has such modules, you can check by making a platform connection to it,
then going to the Software Manager view.

= [ |
T Current free space 22,668 KB To be installed 0 kB Estimated free space after i
File |I|1:|‘.d-l=: '-.'Ersi:rnr'l hval, Version | 1
vykonFro vyion 3.8.37.1 | wkon 3.8.37.1 LUp to Date =
warkbench Tridem 3., 38 ridum 3.8, 38 Lip to Ciate

waresheal Tridium 3.8.38 Tradium 3.8.38 L o Cate

web Tridum 38,38 Tridum 3.8.38 Up to Date ﬂ
weather Tridium 3.8, 38 Tridium 3.8.38 Lip to Cate

a. Click the “Installed Version” column header to re-sort, as shown above. Scroll down as necessary.Any
third-party sourced modules must be refactored by the module vendor before the station can be
migrated to Niagara 4. This assumes that all modules installed in the JACE are required by the
controller’s currently running station. Any installed module that is not used by the station is
inconsequential in for migration.

b. If you previously built custom modules of Program components, using the ProgramModule feature and
its “Program Module Builder” view, you must also refactor these modules. This is something you can
do during the migration process.

4. If you will synchronize users from the N4 Supervisor to the AX station that have been assigned an HTML5
prototype, enable the User Defined 1 configuration flag on the web_WebProfileConfig property of
each user prototype slot in the AX station. (This is necessary because the most likely type of user
prototype to be selected is an HTML5 prototype. There is no equivalent prototype in an AX station.
Consequently, by default, the migration tool assigns the first prototype in the list to each migrated user.
This prototype happens to be the Velocity Doc Web Profile.)

5. Make an N4.0 license request for all platforms to be migrated. You need confirmation that these licenses
are ready before migrating the platforms (AX licenses do not work in Niagara 4).

In almost all cases, the calculated host ID remains the same. An exception is if, on a Windows platform,
you are moving from a 32-bit install to a 64-bit install (or vice versa), in this case, the host ID differs.

Be sure to archive the old AX-3.8 license files as well.

Station backup and database migration
Before migrating, you should back up each station and prepare databases for the new system.
Using Workbench, make a station backup of each JACE controller to be migrated, and do the same for the
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job's Supervisor station. Be sure to include history and alarm files.
Then run the migration tool against these stations, with output as N4.0 station copies.

Sometimes, post-migration database “cleanup” may be needed. You should always do a preliminary checkout
of each migrated station.

Supervisor upgrade
You migrate the Supervisor first.

Once migrated, it can start up and communicate with JACE controllers still running AX-3.8 (see Wire
compatibility for related details).

Controller conversion and new station installation

After migrating the controller and Supervisor stations you can convert the controllers and install the new
stations.

Before converting JACE controller from AX, you must successfully migrate its station to N4, including an offline
checkout of it using Workbench. Only then should a conversion to N4 be done.

System cleanup

Following the upgrade of all AX-3.8 platforms to N4.0, including installation of migrated stations, there may be
several areas that need attention.

AX to N4 migration tool and code signing

When running the AX to N4 Migration Tool in 4.3 or later, any program object encountered is signed if a code-

signing certificate has been configured in Workbench.

When the migrator encounters the first program object that needs signing, it prompts you for your code-
signing certificate password.
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Chapter 2. Migration tasks

This chapter provides migration tasks, along with reference details as needed.

Preparing platforms for migration

The following sections describe tasks necessary before migrating stations and upgrading platforms.

Certificate export

If your controllers are configured to use secure communications with signed certificates, the best practice is to
create new certificates for each controller and install them after migration. However, it is also a good idea to
export the current certificates before migration in case you need them later.

To save your existing keys, export them from the User Key Store and the User Trust Store prior to migration.
These are deleted from each controller during migration to N4. After migration, if you choose to not create
new certificates, you can import the exported certificates back using Workbench and a platform connection.

Exporting the certificates

The User Key Store contains all certificates with their public and private keys. The User Trust Store contains one
or more root CA certificates with only their public keys.

Prerequisites:
The company serves as its own certificate authority.

Step 1. Using Workbench, access the controller platform’s Certificate Management utility. To do this,
either open a platform connection and click Tools > Certificate Management or open the station
and double-click on CertManagerService (under Config > Services > PlatformServices).

Step 2. To export the station’s server certificate with its private key, click the User Key Store tab, select
the certificate and click Export.
You need to export the unique server certificate from the User Key Store for each controller
station.

Step 3. Enable the Export the private key check box and enter an encryption password to protect the
private key in this file.

Step 4. To export a root CA certificate, click the User Trust Store tab, select the certificate and click
Export. Typically, this only needs to be done once because the root CA certificate is the same in
every controller station).

NOTE: It is not necessary to export certificates from the System Trust Store as these are default
certificates found in every System Trust Store. It is only necessary to export any additional
certificates that stored in the User Trust Store.

Step 5. Repeat the steps above to export the server certificate for each controller station to be migrated.
Result

Make sure exported certificates files are available to the Workbench PC to use later. For related details, refer
to the Niagara Station Security Guide.

Configuring a station to migrate users

If your N4 users will use the HTML5 prototype, which does not exist in AX, you must enable the User Defined
1 configuration flag on the web_WebProfileConfig property of each user prototype in your AX stations before
running the migration tool.

Prerequisites:
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You have EC-Net 4 Pro access to the remote station.
Step 1. Expand the Config > Services > UserService > User Prototypes node in the station Nav tree.
Step 2. To view the slot sheet, right-click the user prototype and click Views > Slot Sheet.

Step 3. To access the configuration flags, right click the web_WebProfileConfig property.
The Config Flags window opens.
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Step 4. Enable the User Defined 1 flag and click OK.

Relocating the Kerberos keytab file

If your AX-3.8 stations use Kerberos authentication for user services (for example, LdapV3ADUserService) and
they use a “keytab file” supplied by the site’s Kerberos administrator, the migration tool requires this file to
reside under an “Idap” subfolder of each such AX-3.8 station. This procedure relocates the Kerberos keytab
file prior to migration.

NOTE: If applicable, do this before making source station backups for use with the migration tool.
Step 1. Using Workbench, open the station (Foxs or Fox), expand the Config node, and navigate to the
property sheet of the UserService's authenticator.
For example: Services > LdapV3ADUserService > ActiveDirectoryConfig > authenticator

The Key Tab Location property ORD value references the current location of the keytab file.
Keep this view open.
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Step 2. Ifitis a remote station, open a new tab in Workbench, and open a platform connection to the
remote host and access the File Transfer Client view.

Step 3. In the (remote) right-side “Files on IPaddress” area, navigate to stations > stationName, and
create a subdirectory titled 1dap. This is the target location for the keytab file.

Step 4. In the same right-side area, navigate to the Key Tab Location noted in Step 1. Select and
transfer the keytab file from the remote (right-side) to the local (left-side).

Step 5. Inthe same right-side area, navigate to the stations > StationName > |dap folder created in Step
3, then select and transfer the keytab file back from the local (left-side) to the remote (right-side).

The keytab file should now be in the ! stations/stationName/1ldap folder.

Step 6. Switch to the Workbench tab showing the property sheet of the UserService's authenticator and
edit the Key Tab Location property ORD value to match the new location of the keytab file.
Click Save.

Step 7. Save the station (right-click the Config node, click Save).

Step 8. Repeat all steps above for each applicable JACE station to be migrated to N4.
Result

If this is a local AX-3.8 station, such as a Supervisor station, you can use Windows Explorer to make the new
ldap subdirectory under the ! stations/stationName folder, and copy and paste the referenced keytab
file into it. Be sure to update the authenticator’'s Key Tab Location value with the new location, and save the
station database (steps 6 and 7).

After relocating the Kerberos keytab files and updating authenticator properties, test out the operation in
AX-3.8. A successful operation should continue after the station is migrated to N4.

Station backups

For any AX-3.8 platform you are migrating, make a station backup using Workbench. You will use this station
backup dist file as the source when running the migration tool (n4mig.exe) from the command prompt of a
console window.

CAUTION: Backups for the purpose of station migration should be made only from the BackupService of the
running AX-3.8 station.

When you migrate a backup dist that was made using the Platform Backup available from the Platform
Administration tool, this contains all the stations that are on the platform. For non-embedded platforms, this
may be multiple stations, as subordinate stations are often copied to the Supervisor.

You should NOT use the Station Copier to make copies for migration.

The proper source for a migration is Niagara Backup Distribution file from a station's BackupService, obtained
from the host upon which the original station is running. The Backup contains the necessary additional
information to correctly migrate the station; a station folder does not. Also, you should use only backup
distribution files obtained from the host upon which the original station is running for the source of the
migration.

Most of the time there will be one station in the backup that is to be migrated, or at most only a few. If there is
more than one station, you will be shown a list of the available stations in the backup. Then you will be
prompted to enter a choice selecting which station to migrate. Following, is an example of migration tool
output when run on a backup containing nine stations:

INFO [09:48:50 29-Apr-15 EDT][sys] Niagara runtime booted
("C:\Niagara\EC-Net4-4.0.13.3.550") on Win-CE9A-87C6-1526-58EF
[09:48:50 29-Apr-15 EDT][migration]
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[09:48:50 29-Apr-15 EDT][migration] Migrating station backup
_localhost_demo10_4.dist to backup_localhost_demo10_4.dist
The following station folders were found in this backup:

1 badCop

2 badCop_oldPwds

3 cgAxBac

4 cgOrdsAx

5 demoAppliance

6 goodCop

738

8 nccb11320

9 nccb11602s1_ax

Please select a station from the backup to migrate:

8

Station to be migrated: nccb11320

Migrating station nccb11320 to nccb11320

Setting BackupService properties

Niagara AX to N4 Migration Guide

Prior to making a station backup, set properties as needed in the running station’s BackupService. By default,
backups exclude both the history and alarm databases. Other items are also excluded, such as prior saved
station database copies, console outputs, and lock files. In most cases, you want to migrate history and alarms
databases with your station to Niagara 4, so you need to modify default properties.

Prerequisites:

Stations are configured and running on a host compatible with Niagara 4.

In general, this is the recommended backup method for all platforms, and the only supported method when

making a local backup at the Supervisor PC.

Step 1. In Workbench, open the station and access the BackupService property sheet.

36
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hlli: BackupService (Badwp Services)
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Related BackupService properties shown above are:

a. Inthe BackupService for each AX-3.8 station to be migrated (whether host or Supervisor):
Exclude Files: remove *.hdb; *.adb;
Exclude Directories: remove file:Ahistory and file:Aalarm

b. In the Supervisor station’s BackupService, if configured for provisioning:
Exclude Files: remove *backup*;
This allows prior station backups to be brought over to the new N4.0 Supervisor.

Step 2. Review the Exclude Files and Exclude Directoriessettings and make adjustments as

necessary. These two properties apply to Fox online backups, that is, backups you initiate while
the station is running.

Step 3. The bottom two exclude properties apply when you initiate an offline backup with the station
stopped, using a platform connection and the Platform Administration view. By default, alarms
and histories are included (no Offline Exclude Directories entries, also as shown above).

NOTE: Make only online Fox backups (with station running) for any local station, such as a
Supervisor. Otherwise, if you run an offline backup from the Platform Administration view, it
includes all stations that may be on that platform. The migration tool rejects such a backup file, as
it expects only a single station to be in the backup file. Online Fox backups are more convenient
to run than offline backups.

Step 4. Save any changes made.
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Examples

The following figure shows an example BackupService configured in JACE station.

Figure 11. Example BackupService properties in JACE station
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Note that Exclude Directories still includes file:AdataRecovery (not useful in migration).

The following figure shows an example BackupService in a Supervisor station that is configured for
provisioning.

Figure 12. Example BackupService properties in Supervisor station configured for provisioning
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Note that Exclude Files has no entry for: *backup*; (to allow prior provisioning backups to be brought over
to the N4 Supervisor).
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Making source station backups

A station backup (. dist file) from a Backup command is the preferred archive source when migrating AX-3.8
station.

Prerequisites:
The station’s BackupService is configured appropriately.

Step 1. Using Workbench, you can make either a online backup (typical) or an offline backup.
¢ For an online backup, right-click the

Station node and select

fa
Backup Station.

The station continues running while first it saves is configuration locally, then saves a
backup .dist file in the backups folder of your niagara home (install) folder.

¢ For an offline backup, make a platform connection, stop the station from the Application
Director, then, from the Platform Administration view, select Backup.

NOTE:

An offline backup applies to JACE stations only. For any local station, such as a
Supervisor, you must make an online Fox backup (with station running).

After the backup completes, you may restart the station so that it can continue working
while you run the migration tool in preparation to convert the platform.

Step 2. As a best practice, consider renaming the resulting backup .dist file to a short, meaningful
name.
This simplifies typing in the source . dist file name in the command-line migration tool. Do not
rename the .dist extension.
For example, if the file name is backup <stationName> 141221 0757.dist, shorten it to:
<stationName>.dist, where <stationName> is a logical station name.

Step 3. If the new Supervisor or engineering workstation is on a different PC, copy the backup .dist file
to a location on that PC.
If the new station is on the same PC, simply leave all the backup .dist files in the default
backups folder.

For best performance, do not save backup.dist files in the Niagara 4 System home or User
home directories. The files can be located anywhere else, for example: C: \AxBackups.

Step 4. Repeat this procedure for all AX-3.8 stations to be migrated.

Secure license files

Any converted platform (controller, Supervisor, or workstation) requires Niagara 4 license file, as existing AX
license files are incompatible.

* Before upgrading licenses, back up existing NiagaraAX license files for Windows hosts, and store them in
a safe place.

* You can perform migration work on all archived AX-3.8 stations without all N4.0 licenses secured,
provided that you have at least one N4.0 Supervisor or engineering workstation converted and licensed.
However, you should not start upgrading controllers without first securing each license in preparation for
the upgrade process.

NOTE: The Niagara 4 license is not backward compatible with any NiagaraAX install.

* A controller, converted to N4.0 uses the same host ID as before the conversion. Provided its operating
system remains unchanged, a converted Supervisor PC or engineering workstation also uses the same
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host ID as before the conversion.

Any new installation of Niagara 4 (N4.0) on a PC calculates the host ID for the first time. The end of the
installation typically generates a “license request form” for web browser submittal, and includes this
calculated host ID.

You reference the host ID when you request each N4.0 license.

* You need to submit the license request and receive either the license file, or confirmation of it on the
licensing server, before you can use Workbench. For related details, refer to the Niagara 4 Installation
Guide.

* When you receive a new N4.0 license file for your Supervisor, do not copy it back to any NiagaraAX home's
licenses folder on the same PC—otherwise Workbench no longer works. This can also occur if NiagaraAX
host downloads the (N4) license offered by the licensing server.

In hybrid systems that combine both N4.0 and AX-3.8 hosts, you need to retain Workbench to use for possible
station modifications to controllers that remain at AX-3.8.

Run the migration tool

Included with Niagara 4 Supervisor or engineering workstation is a command line utility that you run from a
console. This utility is known as the N4 migration tool or migrator.

About the migration tool

The migration tool takes a source file, typically AX-3.8 station backup .dist file, and outputs a migrated
N4.0-compatible station folder. You can then use Workbench to open a platform connection to the target
platform (for example, a converted controller), and install this station using the N4.0 platform Station Copier.

Important points to remember are:

* A source backup .dist file is not harmed in any way, regardless of the migration outcome. Migration
output always goes to a different location, along with a text log file that contains execution details.

* The migration tool does not require AX-3.8 installed on the same PC, only a path to the source backup
.dist files.

¢ You run the migration tool from the standalone Niagara Console window, typically launched from the
Windows Start menu.

The following is the log generated while running the migration tool on a very simple Supervisor station backup
file. The migrator ran in a standalone Niagara Console window.

NOTE: Running the migrator in the embedded Workbench Console is not supported, as it does not properly
process the necessary user inputs that may be required if your EC-NetAX station contains passwords that need
to be encrypted with a pass phrase.
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Figure 13. Example migration tool processing a Supervisor station backup

C:\Niagara\Niagara-4.1.xx.xx>n4mig C:\niagara\niagara-3.8.111\backups\
backup_Supvsr_150526_1545.dist

INFO [15:48:41 26-May-15 EDT][sys.registry] Up-to-date [92ms]

INFO [15:48:41 26-May-15 EDT][sys.registry] Loaded [32ms]

INFO [15:48:42 26-May-15 EDT][sys] Niagara runtime booted
("C:\Niagara\Niagara-4.1.xx.xx") on Win-23A9-FCD0-B958-4E02

[15:48:42 26-May-15 EDT][migration]

[15:48:42 26-May-15 EDT][migration] Migrating station
backup_Supvsr_150526_1545.dist to backup_Supvsr_150526_1545.dist
Station to be migrated: Supvsr

Migrating station Supvsr to Supvsr
Migration Templates:
1: Controller Migration Template (ControllerMigrationTemplate.ntpl)
2: Supervisor Migration Template (SupervisorMigrationTemplate.ntpl)
You can also use 'c' for default Controller and 's' for default Supervisor template.
Please select a Migration Template: 2
Using Migration Template SupervisorMigrationTemplate.ntpl

Completed Migration

Source: C:\Users\John\Niagara4.0\Rocket Industries\migTemp\Supvsr

Target: C:\Users\John\Niagara4.0\Rocket Industries\stations\Supvsr

Migration Report: C:\Users\jDoe\Niagara4.0\Rocket Industries\stations\Supvsr_miglog
_1505261548.txt

Important Migration Notes - see Migration Report for details
Using Migration Template SupervisorMigrationTemplate.ntpl
config.bog: REMOVED all uses of type niagaraDriver:NiagaraFoxService in bog

In the example above, the migration tool was launched with only the “nd4mig” command and the source
backup .dist file path, without any options or explicit migration output location. As shown, the migration
template was not specified, so the tool paused and prompted for the migration template (1 or 2). After this
was entered, the tool continued processing and completed the migration.

The migration tool posts information while processing the backup .dist file. By default, the migration output
goes to the stations folder of your Workbench User Home, as shown in the following figure.
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Figure 14. Example migration tool output in Workbench User Home (station folder, migration log file)

O Supwsr

O userHome [ backup_Supvsr_150526_1545.dist_miglog 150526 1548.bd

0 daemon

0 etc

0 logging

0 migrationTemplates

0 registry

0 security

0 shared

0 stations
O Bomarc
O Rocket_F3
D Supvsr

D backup_Supvsr_15

In this example, notice that the migration process created a Supvsr folder and an associated log file in the
stations folder. The target station name is automatically determined from the station name inside the station
backup .dist file.

Entries in the log file (migration report) display source and target locations for items written, actions
performed, and so on. If needed, you can use command line options to create a greater level of log detail.

Console choice for migration
You should use only the Niagara console and not the embedded Workbench Console to run the migration tool.

For migration , use the standalone Niagara command line console window, which you typically launch using the
shortcut from the Windows Start menu. You may also use a standard Windows command line tool available at
[C]:\windows\system32\cmd.exe, for example.
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Running the migration tool

With Niagara 4 installed on your PC, you run the migration tool on the AX-3.8 station backup .dist file to
migrate a station, or run it on a saved AX-3.8 BOG file (.bog) if necessary. NiagaraAX does not have to be

installed on this PC—although in many cases, it may be.

NOTE: For any station that uses modules made using the ProgramModule feature, you will need to migrate
those modules to N4 (refactoring them) before the station can be successfully migrated. See Migrating

modules made with the ProgramModule component.

You must have access to saved AX-3.8 station backups, for migrating stations. See Making source station

backups.
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Running the migration tool
Step 1. At the PC, open a standalone Niagara Console window using the shortcut from the Windows Start
menu.

NOTE: Do not use the Workbench embedded Console because it cannot accept keyboard inputs,
and thus it hangs on input selections.

If you have a number of station backups in a single folder to migrate, it may be simplest to
change the console window’s current directory to that location. For example, your console
prompt may be similar to: C:\niagara\EC-Net-AX-3.8.xxx\backups>

The above would apply if you have both NiagaraAX-3.8 and Niagara 4 installed on your PC.
Alternatively, enter the full path to source station backup .dist files in the commands.

Step 2. Enter the migration tool command (n4mig) using syntax that specifies the source backup file, at a
minimum. By default (if left unspecified), the migration output targets the stations folder of
yourWorkbench User Home. Generally, this is the recommended method: specify source file only.

Result

If you changed the console’s current directory to the location of station backups your command could be:
n4mig -t:2 backup_Supvsr_141117_1707.dist

(to migrate a backup .dist with that default file name, for a station named “Supvsr”).

CAUTION: Do not attempt a station migration using theWorkbench embedded Console. This console cannot
accept keyboard inputs, and thus will hang waiting for your input selection. The only workaround at that point

is to restart Workbench.

While the migration tool runs, operation activity is reflected in the console window. When finished, the ending
lines in the console window state where the target output results and log file can be found.

For reference details on the ndmig command, see Migration tool command usage. For general information, see
About the migration tool.

Migration tool command usage
A number of commands may be added on the migration tool command line.

n4mig [options] <source> [target]

Parameter Required? Description / Notes

source Yes Typically the Ax-3.8 station backup .dist file, but it may also be a bog file, palette file,
station folder, or a zip archive of a station folder. You can enter an absolute file path,
or a path relative to the current directory of the Niagara 4 console.

target No (Optional) The output station folder name to write the migrated station or BOG file.
An absolute file path or a relative path can be entered. Any relative path is relative to
the stations subfolder of your Workbench User Home, that is c:\Users\userName\

Niagara4.x\distech\stations
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Parameter Required? Description / Notes

Options

-version

-log:level

-keepTemp

-showSystemLogs

-help, -?

-t:<template>

TIP: Generally, in a station migration you do not specify a target, as you typically want to
retain the existing station name in the migrated station. If it is not specified, the migration
tool derives it from the name of the source, its parent folder, or the name of a folder within
the archive—whatever fits best. The exception is a source named config.bog. In that case, the
target is required. If the supplied target is a relative path, the migration tool targets the result
relative to the root of niagara user home/stations.

If you do specify a target folder name, it cannot already exist (by default an existing
station is never overwritten); however, any file path above it must exist. For a related

example, see Migrator syntax example 2.

Description / Notes

Print NRE version information for this Workbench instance.

Specify the log level, where level is one of the following:

all, finest, finer, fine, config, info, warning, severe, off

The default is “info”. This produces the text log file migration report, which lists all
the changes made to the AX station as a result of the migration. This file is created in
the root of the stations folder in your Workbench User Home. Of course the default

("info”) also includes any more problematic “warning” or “severe” messages.

After becoming familiar with migrations, you could specify the “warning” log level
instead—that lists only the more problematic entries, shortening the log report.

Do not clean up temp directories after execution. If used, a “migTemp” folder is left
in your Workbench User Home, with various subfolders of intermediate files used in the
migration process. Only use -keepTemp option for troubleshooting purposes.

Shows messages from all loggers; does not hide non-migrator logs.

Print the usage information. By default you see this same information if you enter the
n4mig command alone, that is without any other parameters or options.

Overwrite the target station folder, if it already exists.

When migrating a station backup .dist, this is the template type to use, where
template is one of the migration station template types available on your system.
Choices are:

1 = Controller migration template (for example, ControllerMigrationTemplate.ntpl)
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Options Description / Notes

2 = Supervisor migration template (for example, SupervisorMigrationTemplate.ntpl)

NOTE:

You can also use 'c' for the default Controller and 's' for the default Supervisor
template.

Default migration template files listed above are found in your Sys Home folder under
!defaults/workbench/migrationTemplates. An empty migrationTemplates subfolder is
also created in your Workbench User Home, to store any customized migration station
template files. See the Niagara Templates Guide for more details on working with Niagara
4 templates.

Migrator syntax example 1

Here, the current directory of the Niagara console window has been changed to the backups folder of the
AX-3.8 installation home, such that the prompt is C:\niagara\EC-Net-AX-3.8.xxx\backups>

A command is entered specifying only the source, and not target (recommended for station migration).
C:\niagara\EC-Net-AX-3.8.xxx\backups> ndmig -t:1 backup J300E W 150210 1715.dist

The migration tool processes the J300E_W backup .dist file in the current directory, as JACE station, and
the target output goes under the stations folder of your current Workbench User Home. The standard log file
(migration report) is also created in the root of the stations folder.

So here, migration produces these items:

® C:\Users\userName\Niagara4.x\<brand>\stations\J300E W (complete station folder)

e C:\Users\userName\Niagarad.x\<brand>\stations\J300E W miglog 150212 0846.txt (log
file or “migration report)

The name of the migrated station (folder), in this case “J300E_W", is determined by the station name inside
the station backup .dist file, and is not affected by the name of the . dist file. Therefore, you could rename
the source file frombackup J300E W 150210 1715.dist to, say, J3Wbu.dist before running the
migration tool, and run the command (again, specifying only the source):

C:\niagara\EC-Net-AX-3.8.xxx\backups> ndmig -t:1 J3Wbu.dist
You would have essentially the same results, with these items:

® C:\Users\userName\Niagara4.x\<brand>\stations\J300E W (complete station folder)

e C:\Users\userName\Niagarad.x\<brand>\stations\J3Wbu miglog 150212 0847.txt (log file
or “migration report)

This may be useful to reduce the amount of typing in the console when migrating stations to N4.

Migrator syntax example 2

Here, the Niagara console window has been left at the default N4.0 directory (say when you open it from the
Niagara 4 Console Start menu shortcut), and absolute source and target directories are specified.

C:\niagara\EC-Net4-4.1.xx.xx> ndmig -t:2 -log:finer C:\niagara\EC-Net-AX-3.8.xxx\backups\
backup BigSup 150210 1730.dist F:\migratedStations\BigSupN4
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The migration tool processes the station BigSup backup .dist file from the absolute source path given, as a

Supervisor station, and the target output goes to the absolute “F: drive” location given (perhaps a removable
USB drive) in folder migratedStations\BigSupN4. The log file (migration report) is also created there, but
with finer level detail than the default.

So in this case, migration produces these items:

* F:\migratedStations\BigSupN4 (complete station folder)
e F:\migratedStations\BigSupN4 miglog 150212 0835.txt (log file with finer detail)

The folder F: \migratedStations must already exist, or else the command fails. The specified target station
folder BigSupN4 must not already exist, or else the command fails—it never overwrites an existing station
folder (unless the -o option switch is included in the command).

The target station folder determines the migrated station’s name, unlike when not specifying a target station
folder. In this example, the output station folder (and N4 station name), will be BigSupN4, which is different
than the one in the source backup .dist file. Generally this is not recommended when migrating stations,
especially if they are part of a NiagaraNetwork of stations, as other stations store remote station names (in
configurations of NiagaraStation and StationRecipient components, as two examples).

Therefore, when a migrating a station from an AX-3.8 station backup .dist file, it is typically best to specify
only the source .dist file name, and not specify any target. An example of this is described in Migrator syntax
example 1. After the migration tool completes, if needed, you can then manually copy or move the migrated
station folder to another location. For example, you could copy the migrated station folder under a previously
created "F:drive” location, say F: \migratedStations.

Migrating modules made with the ProgramModule component

If your installation uses custom modules of Program objects (components) made using the ProgramModule
component, they must be refactored for Niagara 4 before using them with any migrated AX-3.8 stations. If you
do not migrate the, Program objects they will be deleted in the migrated station.

Prerequisite: You need a working knowledge of the AX-3.8 ProgramModule (available in the program module’s
palette), including its Program Module Builder view.

Figure 15. ProgramModule in AX-3.8 program palette

S — O
& @ (q [ pregem -
E-48 Program

-5 PragramServics
[ gy ProgramModule ]
EHL) Templates

In the NiagaraAX installation, there are different ways the ProgramModule feature can be used to create
versioned module JAR files that contain one or more Program objects:

* ProgramModule components copied into a folder under the Workbench file space of the local host, such

as a Supervisor, each saved as a BOG file. These ProgramModule components contain Program objects
copied from stations, used to build local modules with these Programs.
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NOTE: This is the recommended use of ProgramModules.

Figure 16. ProgramModules saved as BOG files in the Workbench file space
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The figure above shows two such ProgramModule BOG files, under an “AprogBldr” folder in the
Workbench home. The resultant module JARs are also shown in the local modules folder.

* One or more ProgramModule components copied into a station run on a local host, such as a Supervisor.
Typically, this station also has the original Program objects that are now replicated in the station via local
modules built by the ProgramModule(s).

¢ Simply using the Workbench program palette and the ProgramModule in it, pasting in Program objects
from stations, then compiling and building local modules with these Programs. In this case,
ProgramModules are not persisted—only the modules built using them.

NOTE: Such modules cannot be refactored for N4, unless you first use Workbench to copy
ProgramModules from the program palette into a folder in the Workbench file space, and reconfigure again.
Once saved as AX-3.8 BOG files, you can run migration on the ProgramModules.

In all but the last case, migration of the modules is straightforward. Migration requires running the source
AX-3.8 ProgramModule through the migration tool (either as a BOG file, or if within a station, in a station
backup .dist file). Next you use Workbench on each migrated ProgramModule to recompile the contained
Program(s) and then rebuild the module, which refactors it for Niagara 4.

Migrating modules from ProgramModules saved as BOG files

If you have saved one or more ProgramModule components in your Workbench file space, you can run the
folder (BOG) file containing them through the N4 migration tool.

If necessary, you can do this on a PC still running an AX-3.8 Supervisor station, but with both Workbench and
Workbench installed.

Step 1. At the Workbench PC, open a console. This can be either a standalone Console window or the
Console available in Workbench. See Console choice for migration.

Step 2. Enter the migration tool command (n4mig) using syntax that specifies the source folder with
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Step 3.

Step 4.
Step 5.

Step 6.
Step 7.
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ProgramModule BOG files. If using an absolute file path, an example command could look similar
to:
ndmig C:\niagara\EC-Net-AX-3.8.xxx\AprogBldr

for the AprogBldr folder as shown in the previous Figure 17 on page 34. Leaving the target
unspeciified (as here), results in a subfolder under stations in your Workbench User Home".

NOTE: After the tool finishes, you can simply cut and paste this “non-station” folder to a better
location.

1 — o oE]

Cr\Usera\John\Niagara4d>ndmig d:\niagara‘\Niagara-3.8.38\AprogBldr

16:40:32,074 INFO [sys.registry] Up-to-date [85ms]

16:40:32,179 INFO [ayas.registry] Loaded [94ma]

16:40:34,307 INFC [sys] Niagara runcime booted ("D:‘\Niagara'\Niagara-4.0.2.362%) on Win-E8BC6-2936-T4EL-BIAB
16:40:34,356 INFO [migration] Migrate:
spurece=d:\niagaraiNiagara-3.8.38'\AprogBldr

target=C:hUsers\ John\Niagarad'stationa’\AprogBldr

16:40:36,573 INFO [migration.bog] modified ProgramModule dependances to [nre=d.
16:40:40,770 INFO [migration.bog] modified ProgramModule dependances to [nre=4.
16:40:42,311 INFO [migration] Completsd Migratian
Source:d:\niagaratNiagara-3.3.38\AprogBldr

Targerc:C:\Dsars' John\Hisgaradstations\AprogBldr

logfile is available at C:\Users'Jchn\Hiagara4istations\AprogBldr miglog_141203_leé40.txc

C:\Taers\ John\Hiagarad>| -

rbaja=31.E;program-re=4.
;baja=4.0;program-rit=+4.

(==

seonerol-re=4.0;]

=]

While the migration tool runs, operation activity is reflected in the console window. When
finished, the ending lines in the console window state where the target output folder and log file
can be found. As shown above, you are not prompted for a station “type” (unlike if migrating
the AX backup .dist file).

If the target folder was created in your stations folder, move (cut and paste it) to another location
in your Workbench User Home. You can do this in the Nav tree, using right-click commands.

In the Nav tree, expand the target folder to see the BOG file(s) with ProgramModule(s).

Double-click a ProgramModule for its Program Module Builder view.

| i _'i ] ] ioh h & _ﬂ L A
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i ﬂ- |j My Network |'] 7)) modulehiame h'cu:?::q‘::]ﬁlnd‘.;].el

2| |5 desoription [twe Programs

|
o= My Host : Opliplex380 I
w=i My File System (0 wendor [zeus company |
-‘E Sye i) vendorversion 1.1 ]
150 user Home
5 AgrogBid:
@ ProgramModule. bog
e Frogramiodule

“p SumProgram

o programviociderbog [ [& acd | KN & o Fro=ty sheet
& ProgramModule Achons ]
r:l cerManagement ﬁ New " L Wire Shast :E
L5 deemon ol dinsninn B Categery Sheet
== P - [ Pt Tans —_—

Right-click one of the contained Programs and select Views > Program Editor (as above).

In the Program Editor, click [§] Save & Compile (ProgramEditor > Save&Compile). Activity occurs
in the console area at the bottom of the Workbench window.
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If successful, the Program status should be up-to-date, and the

Save Bog icon should be available.

Step 8. Click Save Bog.

NOTE: If a Program compile fails, you must make one or more modifications to that Program,
working in its Program Editor.

Step 9. Repeat steps 6 and 7 for all Programs in the selected ProgramModule, so that all Programs have
been successfully compiled and saved.

Step10. Double-click the ProgramModule for its Program Module Builder view, then click Build.

32 Build Module [
Running Miagara Build

As shown above, a popup dialog appears while the module is created. Completion may take
several seconds. Related details should also appear in the console area at the bottom of the
Workbench window.

Step11. I multiple ProgramModules are in the folder, repeat steps 5 through 9 for each one, so that a
module for each is created. In the example folder shown here, there are two ProgramModules.

= = a, = Al |
= 1 | Mav
= @ My Networ] 7 || [piame Type Size Modified
E_ Sys Home 1= | 1) wesabher-wd. jar ModuleFile 299KE 21-Mov-14 139 AME & |
— = | |} weatherUnderground-rijar ModuleFile BKE 21-how-14 12:39 AMH
i bin T wesb-rt. jar Modul=File 346 KB T1-Mov-14 12:19 AM B
I deanDist T} webChart-r jar Modul=File 19 KB 21-Mov-14 12:35 AME
) defaults ) webChart-und jar ModuleFile = 1,082 KE 21-Mow-14 12:38 AMH
3 dos {7 webEddors-ux.jar MoclsFile = 2,660 KB|21-Mov-14 12:25 AME
B eic (7} wirechest-wh.jar MadulaFie 182 KB| 21-Mow-14 12:26 AME
- [} workbench-wh.jar ModulsFile 2,063 KE 21ov-14 13:25 AME
O ye T yourPrgmModuie 11t jar Modul=Fils 4KE 04-Dec-14 10:30 AM B
b {7 yourPrgmModule2-rt jar Maochil=File 3 KB/ 04Dec-14 10:51 AM B
) pwave-rtjar Modul=Fil= BRS KB 21Mow-14 12:39 AM B
aaphp-rt.jar L) owave-wb. jar ModuleFile 47 KB 21-Mov-14 12:35 AM E—|
- -

As shown above, the modules named yourPrgmModule1-rt.jar and yourPrgrmModule2-rt.jar
were created by the two ProgramModules.

Step12. When finished migrating modules, close and restart Workbench. This is necessary to update the
registry. Modules should now be ready when running the N4 migration tool on a backup .dist
file of any AX-3.8 station that uses them. See Running the migration tool.

Migrating modules from ProgramModules in a station database

If ProgramModule components are used within the AX-3.8 station (instead of in standalone BOG files in our
Workbench file space), you need to migrate that station in the standard way, that is using a station backup
.dist file as the source.

Prerequisites:
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However, before installing that migrated station, or any other migrated station that uses modules produced by
it, you must use Workbench to get refactored modules from its ProgramModules. This means recompiling and
saving Programs in each ProgramModule, then running a build on each one. Then you must migrate that
station again (now that the necessary refactored modules are available).

NOTE:

If necessary, you can do this on a PC still running the AX-3.8 Supervisor station, but with both Workbench and
Workbench installed.

Step 1. Run the migration tool on the saved AX-3.8 station backup .dist file.

Step 2. Inthe Workbench Nav tree, expand the stations folder under your User Home, to see this newly-
migrated station.

Step 3. Expand the station’s @ config.bog file, and navigate to the first ProgramModule.

Step 4. Double-click the ProgramModule for its Program Module Builderni

== ~ = FIE |
A Program Module Settings £
£ [@Myhetrork ~] | | @ moduletiame  [aaregEMedule
My Heest : Dptislex 330 {0 description~ [Two Timers Used B Lot
e s (3 vendor [four Company
PR Sys Home
) User Home -— {0 vendoriersion [1.0
5 Aprogeidr Name

I stalions e

£ 26 gast @ Cocowder [N & : proverty sheet

e Actions ¥
L Supvsr — hieve p| 1 Mire sheet
i alarm S [ Category Sheet
T N <3 Edt Tags B AX Sot Sheet
0 config. bog «— Make Template g Relation Sheet
lﬁ’ Services
ut Maw Wiew
= DCrivers e c -
B Ao ™ Copy @ Gukde Help
'] Logic If%) Paste £ Bmadoc Help
o MasterScheds Spy Local
S Program [P Duplicate 5
& HingarahietworkJobPrs i Delete
[ J e
badup_Supvsr_141204_1345.dst_ Link Mark
I':| stabionTemplates
G temp

Step 5. Right-click one of the contained Programs and select Views > Program Editor (as above).

Step 6. In the Program Editor, click [§] Save & Compile (ProgramEditor > Save&Compile). Activity occurs
in the console area at the bottom of the EC-Net 4 Pro window.
If successful, the Program status should be up-to-date, and the

k)

Save Bog icon should be available. Click Save Bog.

NOTE: If the Program compile fails, you need to make one or more modifications to that
Program, working in its Program Editor. See Modifying Program objects.
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Step 7. Repeat steps 5 and 6 for all Programs in the selected ProgramModule, so that all Programs have
been successfully compiled and saved.

Step 8. Double-click the ProgramModule for its Program Module Builder view, then click Build.

#2 Build Module

Rurning Magara Buid

As shown above, a popup dialog appears while the module is created. Completion may take
several seconds. Related details should also appear in the console area at the bottom of the EC-
Net 4 Pro window.

Step 9. If multiple ProgramModules are in the folder, repeat steps 4 through 8 for each one.

[= = a) = B\ |
= = | Mav
: o= & My Netwerk |
.
IE“HLI = l=Fil T1KE 31-hiov-14 12: 26 AMEST
Sibn MackuleFil SKE 04-Dec-14 2:28PMEST |
53 deanist ) sepup-rtjar MadubeFile 167 KE 21-+ov-19 1226 AMEST
) defaues T sepup-wh jar MacksbeFile 36 KB 21-Mov-14 12:26 AM EST
I docs L) alarm-ri.jar Maodul=File 292 KB 21-how-14 12:19 AM EST
55 et = | L alarm-se.jar MaduleFile 21KE 21-Mov-14 12:26 AMEST
L) alarm-Locjar Maodul=File 480 KB 21-how-14 12:26 AMEST
Sre O alarm-vebs, jar MacksbeFile 441 KB 21-Nov-19 12:26 AM EST
(=] T slarmOrian-rt.jar MadkuleFils B2 KB 21-ov-14 12:26 AMEST
(8] e | T} andoverAC2S6-rt.jar MacksleFile 106 KE 21-Mov-14 12:27 AMEST
| asphortar ) andover AC256-wb.jar MaduleFile IIKB|21-Mov-14 12:27 AMEST
f a b {ar 0 andoverTnfinity-rt jar MacksbeFile 125KE 21-ov-14 12:27 AM EST
= ) andovesTnfinity-wb, jar MaduleFile 25 KB|21-Mov-14 12:27 AMEST
_ adfrgmiiadule vt O apprtier : MacksleFile 13KE 21-Mov-14 12:27 AMEST
azpup-Ttjar ) apo-wh.jar MadleFile 6 KB 2 1-Mov- 14 12:27 AM EST

As shown above, the module named aaPrgmModule.jar was created by the ProgramModule.
Step10. When done migrating modules, right-click the station’s config.bog file and click Save.

Step11. Close and then restart Workbench. This is necessary to update the registry. Migrated modules
should now be ready when running the migration tool on AX-3.8 station backup .dist files,
including the station with the source ProgramModules.

Migration details

Details on migration are in the following reference topics:

Migration execution

The migration tool migrates a source artifact to its appropriate N4 target. The typical source is AX-3.8 station
backup .dist file. The output (target) is a station folder, in your Workbench User Home.

At the conclusion of the tool execution, you see these Source and Target locations listed:
09:31:37,355 INFO [migration] Completed Migration

Source:C:\niagara\EC-Net-AX-3.8.xxx\backups\backup_Supvsr_141117_1707 .dist
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Target:C:\Users\John\Niagara4.x\distech\stations\Supvsr

You can then install this migrated station into the daemon User Home of Niagara 4 platform, for example the
local platform if a Supervisor, or in a remote platform, such as the migrated station for a controller that has
been converted.

Upon execution, the migration tool scans each folder and file in the backup recursively, and migrates each in
turn as appropriate. Certain folders, such as the folder tree comprising the history database of a station, are
handled separately.

NOTE: Any environment files in the backup .dist that are outside of the station folder, for example,
properties files in the AX platform’s ! /1ib folder, are not migrated. If you know of any that were edited from
default values, and they still apply to N4 platforms, you may need to re-apply changed values in the platform
after upgrading to Niagara 4 (however, do not copy entire AX files into the N4 environment).

If desired, do this after installing the migrated station.

For each migrated artifact, the migration tool determines if a FileMigrator is registered to handle migrating
that file type. If no special migrator is registered, the default migration is to simply copy the file as is from the
source location to the target location.

In the case of BOG file migration, the BogMigrator opens the .bog file, and walks the XML element tree. For
each element it encounters, it checks to see if there is a BogElementConverter registered to handle converting
that type.

* If no converter is registered, the type is simply passed through and re-encoded.
* If a converter is registered, the converter is given the element to process.

e If the element cannot be decoded, this is usually because the module that contains the type existed in AX
but was removed for N4. In this case the element will be removed from the station.

* In the case where the N4 equivalent module exists, the registry check provides a converter that can
convert the obsolete type into the appropriate N4 type.

Migration report (log file)

The log file produced each time you run the migration tool answers the question “What did the tool do?” At
the default info log level, the migration report lists the changes made to migrate the source to the target. If

needed, you can have the migration tool generate even more detailed output by specifying another log level
(config, fine, finer, finest) as an option in your command.

You should always review the migration report to make sure that:

* Nothing was removed that is critical to your station’s operation.
* There were no failures, or items that could not be migrated by the tool.
In some cases, issues may require post-migration “cleanup” tasks.

Inspecting migration reports (log files)
We recommend you inspect migration log files for:
e Migration failures

If any migration failure occurs, this will be noted in the report. You should report any migration failures to
your support channel. In some cases it may be necessary to modify this part of the station manually, and
your support channel should be able to help with that.

* Program compilation failures

The migration tool attempts to recompile all Program objects in the station with the new modules. In
some cases, this may not be successful. Programs that cannot be compiled will be noted in the report, and
you will need to modify the program manually to allow it to compile.
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* Removed station components

Station components whose type or module does not exist in N4, and for which there is not a type to
migrate to, are removed. This should not occur frequently, as the modules that were removed for N4 were
generally unused or deprecated modules.

If you find that a component has been removed that should not be, please report this to your support
channel, as it may be that a converter needs to be developed for that type.

e Any WARNING or SEVERE messages

These messages are included in the migration report prefixed by “WARNING" or “SEVERE", as
appropriate. They indicate a more significant issue, likely a problem with the tool execution. You should
inspect items referenced in such messages to make sure migrated artifacts are what you want.

Post-migration database tasks

Sometimes you may need to perform post-migration tasks on migrated station databases, using Workbench.
For example, certain Program objects may need to be changed and recompiled in Niagara 4, as flagged in the
migration report (log file). Other possible station changes may be needed too, in certain circumstances.

Modifying Program objects

The migration tool attempts to compile all NiagaraAX Program objects (components) in the station to be
compatible with Niagara 4, flagging any that fail to compile properly in the migration report, or log file. Using
Workbench, you should modify any such Program objects until they recompile successfully, before installing the
station.

Prerequisite: You must have a working knowledge of Java programming, Program objects, and the Program
Editor view in Workbench. Access to Developer-level Niagara 4 documentation may be needed.

Modifying and recompiling Program objects offline

You can open a station offline in Workbench to modify and recompile Program objects if necessary, resaving
the station (config.bog file) when done. If necessary, you can do this on a PC still running an AX-3.8 Supervisor
station, but with both Workbench and Workbench installed.

Step 1. Open Workbench, if not already open.

Step 2. Inthe Nav tree, expand My File System and navigate to the station folder of the migrated station
that had Program compilation failures.

Typically, such stations are under your User Home, under the stations folder.
Step 3. Expand the station folder, and expand the config.bog file under it.

Step 4. In the station database, navigate to a Program object identified to have a “compilation failure” in
the migration report (log file).

Step 5. Open the Program Editor view for the component. (One way is from the Nav tree, right-click the
Program and select Program Editor).

Step 6. In the ProgramEditor menu or toolbar, click « Compile.
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& Import Type
@ Import Package
2 Remove

© Add Slot Hate,

() Imparts | &5 Source

1) Reoeder

fram® defines the text that wil

Save B Compile

public wold onStartcy) throws Exception

f start up code here

One or more errors result in the Console area at the bottom. Often all possible errors are not
included, as the compiler stops on failure and outputs an error. Therefore, once you correct one
or two errors, subsequent compile attempts may uncover other errors.

= = ® % ® [ 'Slogc '®Progame W MamProge o AdedlAlarme

I’ 1 1
= |2 | Mav @ Program cannot be compiled,
& ¢ -
¢ [@f] wEat [ Sots | () Inports | Source |
I MarmProgs = 1
[ .bm fF get alarm =ervice
BAlarmService as = [BAlarmService)Sys.getService (EAlarmService . TYPE);
bocHardware
/focursor recorda
Cursor csor = as.getAlarmbb () .getOpenhlarma() I
while |caor.nexc())
{
BAlarmRecord currentRec = as.getAlarsDb (] .getRecord( | (BAlarmRecord) csor.geti) ]
lmst_141201_1914.dist currentRes. ackil arm | “progran”™) ; Frases ackTims, acklser, ackStatse
41117 7 di as.ackilarm{currentBec); //routes the alarm co the alarm service, which route
e ffaaves it in the alarmib, and routea it to all reci
- } fiend while
4 L

C:\DOsers\John\Hisgarad>"D:\Niagara\Hiagara—4.0.2.362jre\bin\ javac™ —encoding UTF-8 -profile compactd -X1il=
Frog_21d448b062548ed21d448b06254Bed. Java:59: error: cannot find symbol
Curaocr casor = as.getAlarmlb() .getOpenhlarms () ;
-

sysbol: method getOpenhlarms()
location: class BAlarmDatabase
Prog_214448b062548ed21dd4Bb0E254Bed. javat 631 error: cannot find symbol
BAlarmfecord currenthec = as.getRlarmbi() .getRecord(({BAlarmBecord)ceor.get ()] .gecluid())
aymbol: method getRecord (BUuid)
C:\Uzers' John\Hiagarad> -

G

In this example, errors shown relate to the methods getOpenAlarms() and getRecord(BOrd)
having moved from the BAlarmService class to a new AlarmSpaceConnection class, located in
the javax.baja.alarm package of the alarm module. To fix this, you would need Developer-level
documentation on “breaking changes” in Niagara 4 Alarm API, and make the required changes
in the program code (further details are outside the scope of this document).

Depending on the Program object, other possible compile errors may require changes in its
package import definitions (Imports tab).

55



Migration tasks Niagara AX to N4 Migration Guide

Step 7. Continue with changes until the Program compiles successfully, and click [§] Save & Compile and
also kg Save Bog.

Step 8. Repeat steps 4 through 7 for each Program object identified to have a compilation failure.

Step 9. When finished, in the Nav tree right-click the station’s config.bog file, and ensure |5 Save is
dimmed. If available (not dimmed), click Save.

Considerations if a station functions as an oBIX server

With the Niagara 4 addition of the new AuthenticationService, any oBIX request to a station must be
authenticated using the “HTTP Basic Scheme” (HTTP Basic Authentication Scheme). If your station has an
ObixNetwork that operates as an oBIX server, note that it is not possible for the N4 migration tool to
determine which station users were used for oBIX authentication.

Since the HTTP Basic Authentication Scheme is assigned on a per-user basis, the migration tool updates the
authentication by completing the following steps:

1. Adds an HTTP Basic Authentication Scheme from the baja Palette to Services -> Authentication Service ->
Authentication Schemes

2. Creates a new user (the default name is "obix"). If a User with the name "obix" already exists, the
Migration Tool will try "obix1", "obix2", etc. until a free username is found.

3. Sets the Authentication Scheme Name of the User created in Step 2 to the HTTP Basic Authentication
Scheme added in step 1.

NOTE: The password assigned to this user is the default password. It cannot be used by oBIX clients until
you manually assign a password.

oBIX authentication configuration

After migration, you MUST perform the following additional configuration to allow OBIX clients the proper
access to the station's oBIX server. These requirements apply to the default "obix" User created during
migration or any other User that you are using to allow oBIX clients access.

Step 1. Open Workbench, if not already open.
Step 2. Inthe Nav tree of the migrated oBIX server station, expand My File System and navigate to the
station folder.

Typically, such stations are under your User Home, under the stations folder.
Step 3. Expand the station folder, and expand the config.bog file under it.

Step 4. Expand Services > UserService and double-click on the newly created “obix” user to open the
Edit User dialog box. The user that the migration tool created is a user name begining with the
letters “obix”, such as: “obix”, "obix1”, "obix2", etc.

Step 5. In the Edit User dialog box, make the following changes:

* change the user password from the existing default value to a password that complies with
the Niagara 4 password configuration requirements.

* assign a Role to “obix” user that allows access to the necessary station components that you
desire to be accessible to oBIX clients.

* verify that the user permissions include read access to the ObixNetwork in order to provide
access to the ObixNetwork in order to provide access to the oBIX Lobby of ther server.

Step 6. Click the OK button to close the dialog box and save the station changes (e.g. in the Nav tree,
right-click config.bog and click Save).

Tips for Configuring oBIX Authentication
The following list includes tips and considerations for configuring oBIX stations after migration.
* Assign Role from a previous user
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During migration, the Niagara Role is created for each AX User in the station. If the AX station was being
accessed by OBIX clients, you can probably pick the User that clients were using, and simply select the
Role with that name as a starting point for N4 oBIX client access.

® Separate Users for each Client

Consider using a separate User for each oBIX client (or client type) that accesses the station's oBIX server.
This is another way to increase the security of your installation by encapsulating access and giving each
user the minimum access necessary to accomplish the needed function.

Preliminary checkout of migrated stations

Prior to installing stations, we recommend that you use Workbench to open each of the migrated stations
offline, that is in the stations folder under your Workbench User Home, and check it out carefully. If necessary,
make and save any changes.

As for migrated JACE stations, if you have an extra, available JACE controller (of the same model type) that
has been converted, you can install a migrated station and observe startup behavior. However, expect many
errors from driver-sourced items—as you would for any unit disconnected from device networks.

Upgrade/convert platforms and install stations
Once you have stations migrated, you can upgrade/convert platforms to N4.0 and install the migrated stations.
Typically you upgrade a Supervisor before upgrading any of its controllers.

Often, you use the same PC to run the migration tool, on the Supervisorstation archives, as well as the station
archives of all controllers being migrated. When this is the case, you usually do not choose to “Install and start
the (N4.0) platform daemon” when first installing the Niagara 4 software. This lets the AX-3.8 platform daemon
continue to host the Supervisor station while you use the migration tool. It also lets you become familiar with
Workbench, and yet still haveWorkbench available for interim tasks.

NOTE: When installing Niagara 4 software on the Supervisor PC, be sure to select the option “This instance of
Niagara 4 will be used as an installation tool”. Refer to the Niagara 4 Installation Guide for details.

Alternatively, you may have used a different PC to run the migration tool, and perhaps even to (eventually) use
as the new Supervisor host for the job.

As different combinations are possible in a transition such as this, use the procedures and steps provided to
serve as a general guide.

Copying the Supervisor station

The first step to preparing the Supervisor station is to copy the migrated station.

Prerequisites:
You have secured the required licenses and the station databases are ready to install.

Step 1. After installing Niagara 4 on the Supervisor PC and starting Workbench, open a platform
connection to the AX-3.8 Supervisor station and stop the station.

Step 2. At the N4.0 Supervisor PC (with access to N4.0-migrated station folders), install and start the N4.0
platform daemon.
For example, from the Start menu, select All Programs >Niagara 4 4.0.3 > Install Platform Daemon
In some cases, this daemon may already be running; however re-installing causes no issues.

Step 3. Start Workbench (if not already started) and click Tools > Options > Station Copier Options.

March 12, 2025 57



Migration tasks

58

Step 4.

Step 5.

Step 6.

Step 7.

The Options window opens.

Niagara AX to N4 Migration Guide

& Opticns [
& Genwral | |
£ plarm Consale
£ plarm Portal B2 Station Copier Options
5% Text Edibor D File Pattern Exdude List [*.1:|:]: conacle.* config.bog.b* config ba

A Lexicon Editor {0 Directory Pattern Exdude List [

Vi P Analyzes 3 Copy Remole Station Alarm Data

i | Bajadoc

= . {0 Copy Remote Station History Data m
'+ Station Copier Opbons _n
{5 Px Editor

1 Wire Sheet

Wb Browssr

[ox ][ concet |

Set Copy Remote Station Alarm Data and Copy Remote Station History Data to true, and

click OK

Open a local platform connection (in the Nav tree, right-click My Host, and choose Open

Platform).

After platform login, go to the Station Copier platform view.
Ready-to-install migrated stations are on the left side, in your Workbench User Home, and there is
no station installed on the right side, in the daemon user home (localhost).lf your migrated station
folders are not on the left side, copy them into your User Home. For example in: C: \Users\

userName\Niagarad.x\distech\stations

Select the migrated Supervisor station, and copy (install) to the daemon user home.

March 12, 2025



Niagara AX to N4 Migration Guide Migration tasks

#= My Host : Optiplex330 (Supver)  — Platform =
'Elﬁv
: 'ﬂ- m Statons. on this computer 5t e
w5 My Host : Opkplex380 /C:/Users/John/Niagarad.0/q (3 [atations
b =i My File System JI00E_THE

b i My Modules
b sl memary

J6E_Fast

& Copy files from selected drectories
< Copy onfy the “tonfig bog” station database fie

[#] START AFTER INSTALL: Start the station immediately after it is copied
[#] AUTC-START: Start the stabon every tme the platform daemon starts

R N I

Step 8. To transfer in this station copy, choose to Copy files from selected directories, and START
AFTER INSTALL... and AUTO-START. .. and click Next. As shown below, select all station folders
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Files in the following drectories will be copied from the local computer to ocalhost™

) ~stabions/Supvar

) ~=tatione Supver jalarm

) ~estationsSupvsr fhistory

£ ~stations/Supvsr fhistory fseg L

() ~stations Supvsr fhistory fsag 1/16E_East
~statians, Supvsr history fs2q 1/J6E_Eastfseqd

-

Step 9. Select all station folders to be transferred and click Next > Finish.

Performing station cleanup

After copying the Supervisor take a moment to confirm that the copy was successful and make any needed
changes to properties.

When the station is copied, open the Application Director and observe startup messages. Then open a local
station (Fox or Foxs) connection to the Supervisor when it has started, and begin preliminary checkout.
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Figure 17. Network Manager view

=] s d

&2 El 2 @ EF |
Name Exts Address Haost Model | Version Status |Health

[k 25E_East N S of [ p:192.168.1.36  NPMEE 38.3 {ok} | Ok [22-Dec-i4 i:0
[E] 1202 Testw oy S g [ p:192.168.1.50 MPM2 3.8.3 {ok} | Ok [22-Dec-14 1:0
[E 1300E_T38 A 0 S P [y p:192.168.1.33 NPM3 3.8.3 {ok} | Ok [32-Dec-14 10
4] [ D

J-_..HHUFDHE‘ | New | Edit || Hm | Cancel || Add || Match

The figure above shows N4.0 Supervisor’s NiagaraNetwork shortly after migration.

Stations that represent JACE controllers in the Supervisor’s NiagaraNetwork should be communicating, where
all may still be at AX-3.8 (yet to be converted). For any that must remain at AX-3.8 (JACE-2s for example),
review, and if necessary, adjust client connection properties.

Save any changes make before upgrading your JACE controllers.

Controller conversion

Typically, after upgrading a Supervisor, you convert JACE controllers to N4.0—or at least you convert all those
for which you successfully migrated a station. During the N4 commissioning of each JACE, you install this
station as one of the steps in the Commissioning Wizard.

CAUTION:

You must migrate the AX station from the JACE and confirm that the migration was successful first (all
Programs report {ok}, for example), before installing the .dist file.

Converting a controller

Perform the following procedure for each controller for which you have secured N4.0 license, and have
successfully migrated its station database.

Prerequisites:

Workbench is open, you have used it to check the migrated station for this controller, and confirmed that the
migration was successful.

Step 1. Open a platform connection to the controller to be converted, and access the Distribution File
Installer.
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Step 2.

Step 3.

Step 4.

62

The list of distribution files opens.

[C:/niagara/Niagara-4.0.15.1.619/conversion

4 distribution files were found in directory "/Ci/niagara/Miagara-4.0.15.1.619/converzion”
File Version Status Description #

II:} AXtoMN4-gnx-jace-javelina_booke-etfs2048.dist  Tridium 4.0.15.1.612 Modified Converts A¥ unit to N

Dchuuse Directory | &Cleaning | &Cun\rersiun Backups ) Install

NOTE: N4 may display the cleanDist or other files for other controllers, but you can select only
the file that is appropriate for your controller. This file is only for a unit already converted to
Niagara 4. If you do not see the appropriate *.dist file, verify that you are in the conversion
folder. If necessary, use the buttons at the bottom of the view to navigate and browse for the file.

Point the installer to the ! /sw/N4buildNumber folder, for example: ! /conversion/
4.0.15.610.

Only one of several listed should be selectable. This is an example of the file for converting a
controller:

aAXtoN4-gnx-jace-npmbe-etfs2048.dist

Select the appropriate .dist file and click the Install button.

NOTE: Installation clears all data in the controller, including AX licenses and certificates,
environment and properties files, SSL certificates and key files, along with all station data and
NiagaraAX software. The controller’s IP configuration is retained. You must use the default
platform credentials to regain access.

After this . dist file installs and the controller reboots, re-open a platform connection (port 3011)
using the factory default credentials.

If you previously exported SSL certificate stores from this controller, access the platform
Certificate Manager view, and do the following:

a. On the User Trust Store tab, click Import, and navigate to select the previously saved public
key certificate (typically common among all platforms at the job).

b. On the User Key Store tab, click Import, and navigate to select the previously saved private
key certificate unique to this platform.

c. Access the platform Platform Administration view, click the Change SSL Settings button,
and select the new server certificate you just imported.

d. Run the platform Commissioning Wizard (right-click the Platform node, and select
Commissioning Wizard).
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In this initial commissioning of the controller, you typically use all default step selections. This
includes most steps except Install lexicons (but if you use text-based lexicons, select this
too).

1 Commissioning for “192.1681 36" [l

“X_ Commissioning

Thig wizard combines steps for configuring a hast to run stations, Please dwedk below fior eadh type of configuration
change you wish to make:

*
[#] St enabled runtime prafies
Install a staton from the lecal computer
[ Imstall kexicons to suppart addtional languages
*

+

[#] Configure TCP/TP netwerk sattings

Configure additional platform daemon wsers

| Clear Al Check al

Back || B nex | Finis ” - Cancel

In most cases you select to:
¢ Install the licenses from the licensing server (unless you already have these as files).
¢ Use runtime profiles RUNTIME and UX, or else RUNTIME, UX, and WB.
¢ Install the specific station that you migrated for this controller, choosing to:
Copy files from selected directories.
NOTE:

You typically select all directories shown in the migrated station, including the alarm and
history subfolder (to migrate prior alarms and histories). Apart from the migration, this is an
unusual practice. If you are installing the same station in different/multiple platforms, be sure
to deselect (clear) the alarm and history subfolders.

* Install all pre-selected software modules required for this station.
* |Install all listed core software distribution files.
* Review, and if necessary change, the controller's TCP/IP configuration.

* You must add at least one new platform admin user in the “Remove platform default user
account” step (initial Platform Daemon Authentication dialog). This replaces the factory-
default platform user. Note that in N4, platform credentials require a stronger password than
in AX. The password must be at least 8 characters, with at least 1 digit (numeral). If the
password does not meet this requirement, an error dialog prompts you to create a valid one.

Make note of these platform credentials; you should use a login as such a platform user upon
next access.
NOTE:

For this platform session, Workbench remembers the first platform admin user you created to
replace the factory default platform user. This simplifies re-connection after the controller
reboots.
For related details, see the JACE Niagara 4 Install and Startup Guide. Example screen captures
of a few of these Commissioning Wizard steps are shown in the Controller conversion examples
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Step 5. Review and finish the commissioning wizard, to install all selected items and reboot the controller.
After several minutes, the conversion completes, and platform access should be possible.

CAUTION: Do not remove power from the controller during this reboot, which may take up to 7
or more minutes to complete. Removing power could easily cause the unit to become
unrecoverable. If desired (and convenient), you can use a serial shell connection to the controller
to monitor progress as files are installed, the platform is rebooted, and the unit is prepared.

Step 6.

Re-open a platform connection to the converted controller, using a new platform account you

entered in the wizard. Go to the Application Director and view the station standard output.

Again, there may be warnings and messages, but its station status should change to “running”.

Step 7.

In Workbench, open a station connection (Fox or Foxs) to the converted controller, typically using

the admin (superuser) login. Verify the station opens.

= & #la |
-~z | Mav |
ﬁ | & My Network. |T| Mame |EBUDM‘|
] ] L4 Alarm Alarm Clatabass
f f;:';::;-lﬂ:ﬁhzk:?-:;lem ") B config The stabon configuration database
- o106, L0 Lo = Fies File System accessed over Fox session
E Flatfarm ﬁ. Spy Diagnostics informaton for remate ¥
w O Station (MSE_East) 1-, Hierarchy Hisrarchy views of remote station
I larm £y History History database
Canfig
ﬁ' Services
8 Drivers
{3 Niagarahletwark
[ supvr Property Value
[ Bametetaark Siation Mame ME_East
[E ModbusTopSlavetiets Host 192, 168, ].Ell"l‘}l 168,138
£3) Logic Host Model MPPSE
FHosk Id Qnx-HPMSE -0000-175F-9 1F7
=i Files Miagara Version  4.0,5.357
%, Hierarchy Java Version Java HatSpot(TM) Embedded Client VM 25,0570
ﬂh History 05 Wersion Ppc QMY 6.5.0
Locak= =
Current Tim= Z2-Dec-14 5:34 PM UTC

Step 8. For each remainin controller to be converted, repeat the above steps

Result

When done with this, all converted controllers should be running stations as N4.0 platforms, as well as the

Supervisor station.

Controller conversion examples

Following, are example Commissioning Wizard windows when converting JACE controller to Niagara 4.
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Example conversion steps

Figure 18. Example “Set enable runtime profiles” step

The platform daemon can be configured to save space by restricting the modules that can be installed to it

Please choose the runtime profiles which should be used on this host:

[##] RUWTIME: Module JARSs hawving core runtime Java dasses only, no user interface.
[#] Uiz Module JARs having lightweight HTMLS +JavaSaipt+055 user interfaor only.
[] WE: Madiie J&Rs having Wiorkbench or Workbench Applef user interface dlazses.!

] =E: Module JARs having Java dasses Ehat use the ful Java B Standard Edition (SE) platform AP,
] BOC: Module 3485 having no Java dasses,

[ doack |[ Bwext || non [ © cance |

Figure 19. Example “Install station” step (pick migrated station)

"% Commissionngfor 206803 |

If you wish to copy & stalion from the local machine o the remole hast, please select it from the list below:

Hew Name | (Don't transfer a station)

F-Mh”ﬂnlull

As shown above, by default all items are selected. If necessary you can de-select any items not wanted.
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Figure 20. Example platform daemon authentication step (to replace factory platform user)

2 Commissioning for "192.168.1 36" [

© o Platform Dasmon Authentication
Create a new platform user acoount

Please create a new platform user account.
The platform session’s credentials wil automaticaly update to ths account when the commissioning wizard completes.

User Name [MyPlatUser |

Password |I'III-I'III---I |

Confirm Password  [sessssssns |
Comment (optional) flacfore admin uaing|

[ o ][ | o]

If this controller was previously provisioned by the AX Supervisor, you may wish to have at least one platform
admin user with the prior user name, and possibly prior password (if it was “strong” before). Otherwise, you
must update the platform connection Credentials property for this station back in the Supervisor station’s
NiagaraNetwork.

An even better practice might be to add another platform user in the JACE that no person uses to make
platform connections, but is only referenced back in the N4 Supervisor.

Downgrading controllers

In some cases it may be desirable or necessary to convert a controller from Niagara 4 to NiagaraAX. During
the commissioning of JACE controller, all station data are deleted. This includes SSL certificates and key files.
Niagara 4 stations cannot be converted to NiagaraAX stations. But, you can install a previously saved
NiagaraAX station during the downgrade commissioning process as one of the steps in the Commissioning
Wizard.

NOTE: Controller downgrade from Niagara 4 removes all data except the controller’s Ethernet TCP/IP
configuration. Platform credentials revert to factory defaults. The Niagara 4 license is not retained and
NiagaraAX license is required. All station data is deleted.

Downgrade procedure

Perform the following for each controller to be downgraded, and for which you have secured NiagaraAX
license.

Prerequisites:
To restore an existing station, make sure you have access to the station file, or a backup distribution file.

Step 1. At the Supervisor, using Workbench, open a platform connection to the controller to be
downgraded, then open the Application Director and stop any running station.

Step 2. With the platform still selected, choose the Distribution File Installer from the view selector,
navigate to the location of the downgrade distribution file, and click Conversion.

NOTE: Some non-applicable files, such as N4 cleanDist, .dist or other files may be selectable
but, in this case, do not select these files. Click the Choose Directory button to browse to the
location of the downgrade .dist file, for example: N4toAX-gnx-jace-<npm-
model>etfs2048-clean.dist.

Step 3. Select the appropriate .dist file and click the Install button.
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NOTE: Installation clears all data in the controller, including AX licenses and certificates,
environment and properties files, SSL certificates and key files, along with all station data and
software. The controller’s IP configuration is retained. You must use the default platform
credentials to regain access.

Step 4. After this .dist file installs and the controller reboots, re-open a platform connection using
Workbench (port 3011) and the factory default credentials.

NOTE: At this point, the JACE will be at 3.8.38 version. If you need an earlier release AX version,
use the clean .dist files in the AX-3.8 Distribution File Installer. This will revert the JACE back to
the base-factory version.

Step 5. Run the platform Commissioning Wizard (right-click the Platform node, and select Commissioning
Wizard). During the commissioning process you can choose to reinstall a station, if you have one
ready, perhaps from a previous backup, or you can restore from a backup as described in the next
step.

CAUTION: Do not remove power from the controller during this reboot, which may take up to 7
or more minutes. Removing power could cause the unit to become unrecoverable. If desired (and
convenient), you can use a serial shell connection to the controller to monitor progress as files are
installed, the platform is rebooted, and the unit is prepared.

For more details on commissioning the AX-3.8 controller, see the JACE Niagara 4 Install and
Startup Guide.

Step 6. If you did not restore a station with the previous commissioning step, make sure you have a
backup .dist file and a platform connection to the rebooted AX-3.8 controller. Select the
Distribution File Installer view and click on the Backups button or Choose Directory button to
navigate to the appropriate dist file location.

Step 7. Select the .dist file and click the Install button. Follow the prompts in the Distribution File
Installer to complete the installation.
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Chapter 3. System verification

Following the migration and initial upgrade of a system from AX-3.8, there may be additional considerations
and tasks that you need to verify operation.
The following sections include related topics.

Non-default environment files

The migration tool does not migrate all parts of the station backup .dist file. For any AX-3.8 host where you
made changes in properties files or xml configuration files, these settings may need to be re-applied to
equivalent files in the Niagara 4 host.

Some examples of files that may have been modified include:

* system.properties

® nre.properties

* daemon.properties
* units.xml

¢ unitConversion.xml
e facetKeys.properties

In most cases the station should at least run successfully, and these settings can be re-applied once the station
is running under Niagara 4. It may not even be necessary to make the same changes, so you should evaluate
once you have the station running in Niagara 4.

NOTE: Do not copy entire files from the NiagaraAX platform to the Niagara 4 platform, but instead only those
values that were modified from defaults in the equivalent NiagaraAX file(s).

Verify station-to-station communications

Ideally, station-to-station communications between the platforms converted to N4.0 and all others resume
after the upgrade. That is, communications between the Supervisor and controller stations, via the
NiagaraNetwork. Supervisor communications between any JACE stations which remain at AX-3.8 should also
resume. (Note this assumes all station names remained unchanged.)

However, in some cases you may need to take additional steps to restore communications, working in the N4.0
Supervisor stations and/or controller stations (N4.0 JACEs, and if applicable, AX-3.8 too).

NOTE: If configuration of any AX-3.8 JACE station is required, say to edit “client connection” properties of the
NiagaraStation that represents the N4.0 Supervisor, need to use Workbench for this.

Some variation of the following sequence may be required:

1. In Workbench, re-open the Supervisor station and go to the Station Manager view of its NiagaraNetwork.

If new JACE controllers were added (not migrated) there will not be an existing station child for
them—you need to select and add them.

2. For each NiagaraStation in the Supervisor station’s NiagaraNetwork, verify that communications report
{ok}. The status of all stations in the network should be {ok}.

In cases where secure communication (Foxs) is being used with the default self-signed certificates, it may
be necessary to go to the Supervisor’s CertManagerService platform service, and perform other actions.
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The figure above shows allowed hosts exceptions for migrated controllers that need approval. This may
not be necessary, if previously-exported TLS/SSL certificates were imported before commissioning.

3. In a station connection to each JACE controller, go to the Station Manager view of its NiagaraNetwork,
and verify communications to the Supervisor are {ok}.

Again, if Foxs (TLS/SSL) is being used by a Hotspot JACE station back to the Supervisor (and possibly
other JACE stations) you may need to go to the JACE station’s CertManagerService platform service, and

perform other actions.

4. While working in remote JACE stations, after verifying NiagaraNetwork communications back to the
Supervisor are {ok}, verify other “inter-network” configuration is valid. For example, verify the correct
NiagaraStation component (representing the Supervisor) is referenced in the appropriate StationRecipient
component, under the station’s AlarmService. Typically, this is necessary only if station names were

changed when migrating.

Provisioning notes

For any Supervisor migrated to N4.0 that was configured for provisioning stations in its NiagaraNetwork, that
is, using the provisioningNiagara components (for example, ProvisioningNwExt, also BatchJobService), there
may be related post-migration measures needed.

Verify Supervisor to controller platform daemon communications

You need to verify that communications from the Supervisor to the platform daemon of each controller are

{ok}.

Expand the Supervisor’s NiagaraNetwork, and issuing a ping from the PlatformConnection device extension of

each child NiagaraStation.
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The figure above shows successful communications to the JACE platform daemon, using platformssl. However,
you may first need to edit the Credentials property to match a new strong password for the platform admin
account in an migrated controller. And/or, perhaps (again) access the Supervisor's CertManagerService
platform service, and perform other actions.

This station-to-platform provisioning communications is one-way only, from the Supervisor to each controller.
Therefore, no reciprocal configuration in controller stations is needed.

Provisioning considerations when JACE controllers remain

Sometimes one or more JACE controllers may need to remain running AX-3.8, yet continue to be in the
migrated Supervisor’s NiagaraNetwork. This is supported by the N4.0 Supervisor, including many provisioning
operations. For example, the backup of AX-3.8 stations and installation of AX-3.8 software.

For proper support, you should import the software database of the former AX-3.8 Supervisor into the
software database of the N4.0 Supervisor. This copies over all the versioned NiagaraAX software modules and
.dist files to the new Supervisor, and makes them available for provisioning of the older platforms.

To do this when the N4.0 Supervisor is installed on the same PC as the former AX-3.8 Supervisor:

1. Use Workbench to open a platform connection to the N4.0 Supervisor, then access the Software Manager
view.

2. Click the Import button at the bottom, and then Import software from directory.
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3. As shown above, in the Directory Chooser popup, navigate to the AX-3.8 Supervisor’s installation folder,
then expand to find its sw subfolder. Select it and click Choose.

S Anslyzing installable files

@cupmn “IC:jriagaraNiagera-3.8. 38/ow[3.8. 38 rapdEye.jar™

VAL LTI

Progress is displayed in a popup dialog similar to the one above, while software files are analyzed for
versions and then copied into appropriate subfolders in the N4.0 Supervisor’s software database. When
finished copying, the normal Software Manager view opens.

If the former AX-3.8 Supervisor is on a different PC than the N4.0 Supervisor, you perform the same procedure.
However, first copy the entire software database (! \ sw folder) from the AX-3.8 Supervisor to a location
accessible from the N4.0 Supervisor, such as on a USB flash drive, etc. Then navigate to that location from the
Software Manager while platform-connected to the N4.0 Supervisor.

72 March 12, 2025



Niagara AX to N4 Migration Guide System verification

Station User notes in migrated stations

A number of Niagara 4 changes were made affecting station users, meaning User components that are children
of a station’s UserService.

Permissions moved to Roles

The permissions map that every User had (Permissions property) was removed. The permissions map identifies
what operator-level and admin-level privileges are in place for different Category components in the station.

The Permissions property was relocated to Role components (new in Niagara 4), which are children of a new
RoleService in the station. Instead of a User being assigned permissions directly, now you assign each user to
one or more Roles. Permissions of those roles are “OR’ed"” together to specify what privileges a user has on
the categories in the station.

In order to migrate Users from AX to N4.0, while preserving their existing category permissions, note an N4
migration results in a separate Role created for each User—and named identically to that User.

Figure 21. Station migrated to N4.0 has default “one-to-one” mapping of new Roles to existing Users
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This one-to-one mapping of created roles to users is shown above, where user JohnW has (by default), only
one role assigned: also named JohnW. (Note additional roles could be assigned, but are not here.) Effectively,
nothing changed here: the permissions map that used to be in user JohnW'’s permissions property is now in the
“same named” Role component.
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Figure 22. Permissions map of User relocated to Role created with identical name

= Maw
] o My Network E Piame Permissions:
i stasion (suprsta) = 3 admin super
£ slarm {0 MyUn1gUEm2m  super
) * WI:2 3 BT d=rvall'WT; S=rwaR W 6 =rwaRWT; 7=rwifl
=) Config l:I ScotF 1=rwiR'WI; 2=rwiR; 3=rwaR W1 ; A=rwill; S=rwi; 5=rwi; 7=rwi; B=rwi
ﬁ Services l:l Faddan 1= WI; 2 =rwiR; d=rwal W S=reil iy
) UserService l:I Joek 1=rwiRl; T=rwill; 3=rvei; 4 =rvei; S=rvei B=rvei; 7=rvi; B=rvi
& admin 0 e
& guest - .
& User Pratotypag =% Edit ==
£ MyUn1gUEmam
& Johri Permissons
& scotF . e ——p—— - P rp— p—
5 - @ JohnW | 1=rwaR W2 sreaR W3 srwl W 4 srwifUAT; 5 srwib W =rmR W Pl W8 =l W
ﬂ FacMan Zt Name E |
o CategaryService [T Permissions [ Super User [1=puiOWI : 2=rWiBWI : 3=rWiEWI: I=EWwiEWI: S=rw|
RoleService [acress entire station, fie sysiem)
D admin
' MyUn 1gUEmm
@ Johniw 4 ]
@ scotf | oK || Cancel |
2 FacMan
D Jo=k
D user
JobService

As shown above, you can see this in the popup Edit window for each Role (in the Role Manager view on the
RoleService). The role now has the permissions map.

In summary, to make better use of roles, you should consider this a workaround effect of migration. For
example, you could create more duty specific roles and/or rename or delete roles, later reassigning to users in
various combinations. When adding or editing users, this can simplify how permissions are assigned.

The Role Manager lets you do all these things, except the assignment of one or more roles to users. That you
do from editing (or adding new) users in the User Manager, or from User property sheets.

Authentication is user-specific

When looking at a User in Niagara 4 station, notice that the Password property is now inside a new
Authenticatorcontainer, along with Password Config properties. In addition, each User has a specified
Authentication Scheme Name, where the default is typically DigestScheme.

This is part of a new authentication architecture” in Niagara 4. Along with a new (and required)
AuthenticationService and child AuthenticationScheme components, station security is improved, providing
finer control. For the migration of existing station users, typically nothing remains to be adjusted. However,
when creating new users, this architecture may provide added flexibility.

For related details on authentication changes, refer to the Niagara Station Security Guide.
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Chapter 4. Migrating Niagara Enterprise
Security stations

Niagara Enterprise Security stations are Niagara stations that have some additional unique migration
requirements and options. The following topics describe the specific steps required to migrate your
NiagaraAX-3.8 security Supervisor and controller stations to Niagara 4.8 (and later) security stations. This topic
provides an overview of the process.

To reduce downtime, migrate the Supervisor station first and then the individual security stations.

A typical Supervisor station includes persons, badges, access rights, schedules, threat level groups, intrusion
PIN, intrusion zones, Niagaralntegration ID, tenants, new users, new roles, new categories, a PhotoIDNetwork,
and ObixNetwork, PxViews, additional personnel information, an Ldap network, alarm class, custom Wiegand
format, and keypad configuration.

The following list summarizes the aspects of the AX security system that need special migration attention:

* Passphrase: Be sure to have the station passphrase available before starting the migration process.
Depending on the migration scenario you are using, you may need to re-enter an existing passhphrase or
create a new passphrase during the migration process. Refer to “System Passphrase” and related topics in
the Niagara Platform Guide for more details about passphrase usage.

¢ devDriver based video drivers: Niagara 4 does not support RapidEye and Dedicated Micros legacy
devices. During migration, the migrator deletes devDriver-based devices, including these two. If your
installation includes one or more of these devices, please upgrade to the supported devices: Axis,
Milestone and MaxPro video drivers.

If your installation uses the devDrivers for AxisvideoNetwork and Milestone, a procedure in this chapter
documents how to use the Video Driver Upgrade tool to upgrade these drivers to nVideo-based version
of the drivers.

* Remote Video Camera mapping: As part of AX to N4 compatibility restrictions, Supervisor cameras
cannot be discovered under the NiagaraNetwork from an AX controller. So, to migrate cameras to the
new Supervisor station, map them in a Niagara Enterprise Security 2.3 JACE before doing the station
migration. Then, during migration, the new station retains that mapping without additional changes after
migration.

* Backup: Before migration, you will make a backup of the Supervisor station and all subordinate stations.
By default, the BackupService does not include alarms and histories. To retain these database records, you
must specifically include alarms and histories in the backup.

¢ Backup schedules: Before migration you must use the web Ul to unassign any schedules in the
BackupService and re-assign them after completing the migration.

e Photo ID station AsurelD Legacy Device: If you use AsurelD to create photo ID badges, Niagara 4.8 (and
later) does not support the AsurelD Legacy Device. Before migrating, add the newer AsurelD Client
Device to your Photo ID network.

Refer to the “Manually adding a Photo ID device (not legacy)” topic in the Niagara Enterprise Security
Installation and Maintenance Guide for guidance on how to configure the newer Asure ID Client Device.

* Supervisor database support: Niagara 4.8 (and later) supports MySQL 5.6 (and later) and SQL Server
2008 (and later). These are the minimum requirements for the Supervisor database.

NOTE: There is no special procedure for preparing the Supervisor database. If your database is older than
the supported versions, contact the database supplier for software upgrade procedures.

* Remote station database password: The migrator clears the Hsql password in each remote station. After
migration it sets up the default password to access the Hsqgl database. While the database will work with
the default password, you should change it to a more secure credential after migration.
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* Roles: Roles are handled differently in Niagara 4. The migrator removes all AX security roles from the
UserService and moves them to the Niagara 4 Role Service.

e Custom modules: If your installation includes custom modules made using the ProgramModule feature,
you will need to refactor them before migrating the Supervisor and subordinate stations. Refer to
“Migrating modules made with the ProgramModule component” in this guide.

Upgrading devDriver-based video drivers

If you are using one or more devDriver-based video drivers, a conversion tool is available to upgrade these
drivers in each controller station to the newer nVideo-based drivers. You must upgrade these drivers before
you migrate each controller station.

Prerequisites:
Your laptop or PC is connected to the same network as your controller(s) and is running the NiagaraAX version
of Workbench. The driver upgrade module is available.

Step 1. From Workbench, open a connection to the desired controller station (File > Station > Open
Station) and enter credentials with admin privileges.

Step 2. From the main menu, click Tools > Driver Upgrade Tool.
The Driver Upgrade Tool window opens.

1 S R
Host oo 3 o 30 |

Lisername Passmord Part
Platform Connection  [MyPlatfornUsernane | [eeasssns | 3011 |
TR 5 vacicnzernane] |Qjereveeee | [ ]

Step 3. Enter the host address, platform and station addresses and click Next.
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The wizard reads the current station and scans its .bog (station) file. If a driver can be upgraded,
the wizard changes the .bog file and downloads any dependent modules. Be sure that you have
the required modules or an upgrade is not possible.

When it successfully completes the upgrade, the wizard indicates that is was successful.

ZK Performing Upgrade

Push upgraded db and modules to host

o | Install upgrades  Success
+ | Reboot host SUCCESS

| Restart station Success

Installation complete —
Upgrade successful —

|Upgrade successful, press "Finish™ to dose the wizard.

Back Next </ Finish =) Cancel

NOTE:

The wizard does not delete the old devDriver based video driver modules.

Step 4. To conserve space in the controller, delete the old devDriver based modules if they are no longer
needed. devDriver modules that you can delete, include the following:

e devDriver.jar

devHttpDriver.jar

devlpDriver.jar

devVideoDriver.jar
NOTE: The devDriver.jar may be required as a dependency for other drivers. If so, you cannot
delete it while that dependency exists.

Step 5. Delete any older driver modules, such as those for Closed-Circuit TV (CCTV) equipment
associated with the older drivers.

Mapping Supervisor cameras to AX controllers before migration to N4

As part of AX to N4 compatibility restrictions, Supervisor cameras cannot be discovered under the
NiagaraNetwork from an AX controller. This procedure describes a way to pre-configure your station before
migration in order to retain the Supervisor camera to remote controller connection after migration.

Prerequisites:
The camera device address is available. The Supervisor IP address is known.

If you map the desired Supervisor camera to the remoter controller before migration (using this procedure),

the system maintains the camera relationship through the migration process and functions after migration for
use with readers and alarms.
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Step 1. Using the Niagara Enterprise Security 2.3 Workbench, navigate to the following location: Config >

Drivers > AccessNetwork > Remote Reader Module > Points > Door 1 > Reader 1 > Badge Does
Not Exist Alert

The property sheet view opens.

= & (e = © 0 0
- Nav & | |2 Badge Does Not Exist Alert (Activity Alert Ext)
@ |\_\g,l My Network | - | O @ Activity Type |Badge Does Mot Exist |
T B £} Badge Does Mot Exist Alert  Sec Alarm Source Info
B AccessNetwork = Alorm Gl
; arm Class -
Bl [ Base Reader Module oo |}{e::11u.m | |
Er[E Remote Reader Module O @) Source Name |§dEViCEDiSplﬂ§'NﬂmE%-%PEEEUE-PEEEUE - diSpl| @
rf}- Alarm Source Info
: ) [puil |
E"@ Points O & Hyperlink Ord
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O @ Sound File |null |
O @ Alarm Icon |null |
'O Ro2 O @ Alarm Instructions 0 Instructions
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1 @ Exit Request O () Meta Data » ‘B v|
@ sensor O (3 Enable Logging FETER
- @ Strike
ED Reader 1
@ Last Location Id

@ valid Badge

@ Invalid Badge
B+ @ Green

@ Red

@ Beeper -
' o Eadge Does Mot Exist Alert
L 6T Dadne Tr 1 ek Alark

Step 2. To open the ConfigFacets window, click the facets icon (>>) next to the Meta Data property.

d& Config Facets

x
Key Type Value |ﬁ
cameralrd String ip:m.XuX.X.xx¥|foxs:station: |slot: /Drivers/Axiss20Videos20Net
cameraHandleOrd String nrxxax
goToPreset Boolean false =]
cameraPreset DynamicEnum 1 El
sendilarmToDisplay Boolean false =]
startRecord Boolean frue El
EXEYEE

| OK || (anoel|

Step 3. Add facets as shown in the image above (also, refer to details in table below), where

xxx.xxx.x.xxx is the IP address of the Supervisor platform and xxxx is the actual
cameraHandleOrd for the camera you are mapping.
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The following table indicates the key names, type, and values that go in the facets window.

Key Type Value

cameraOrd String ip?xxx.X)I(x.x.xxx\ foxs:station:|slot:/Drivers/
Axis$20Video$20Network

cameraHandleOrd  String h:xxxx

goToPreset Boolean false

cameraPreset dynamicEnum 1

sendAlarmToDisplay Boolean false

startRecording Boolean true

NOTE: The startRecording property works only for Milestone cameras but not for Axis Video
cameras. Set the startRecording property to false for an AxisVideoCamera.

Result
When this task is completed the station is ready for backup and migration as described in the tasks included

with Migrating Niagara Enterprise Security stations topic.

Preparing the BackupService

By default, backups do not include alarm and history records. To preserve alarms and histories you need to edit
the excluded file values.

Prerequisites:
You are logged in to your NiagaraAX Supervisor station with admin privileges.

Step 1. Navigate to the Config > Services node in the Nav tree, right-click the BackupServices node and
select AX Property Sheet from the popup menu.
The BackupServices property sheet opens.

- |2 MNav (| El;ﬁ BackupService (Backup Service)
s @ |y My Metwark |v | O O Status |{°k}
L E Confi =] O (O Fault Cause | |
E—'}lﬁ} Services O (& Enabled

B & UserService O @ Exdude Files |Jl Jhdb; ¥, adb; %, lock; console. ;ccnfig.bcg.]
E]-@ CategoryService file: ~history
B JobService | file: ~alarm
B LY AlarmService O (& Exdude Directories file: ~temp
B2 HistoryService
-2 AuditHistory
Gt LogHistory O & Offine Exdude Files [*.10ck:console.*; config.bog.b* ;config ba
[]-@; ProgramService file: “temp
Bl BackupServics
B2 TimeSyncSery & Backup Manager
B webService 4 M
B % OrionService Mew p| L Wire Sheet

Step 2. Inthe Exclude Files text field, select and delete the following: *.hdb; and *.adb; using your
keyboard and mouse.
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& BackupService (Backup Service)
O @ Status
O (O Fault Cause

O 2 Enabled
O (o Exdude Files

O ) Exdude Directories

O ¢ Offiine Exdude Files

O (& Offline Exdude Directories

[{ok}
| |
O tue ||

|’- Lhdb;*.adbk; *.lock; console. ;ccnfig.bcg.i

file: “history
file: ~alarm
file: “temp

|’- .lock;conscle.¥;config.bog.b¥;config bal

file: ~temp

This includes (not excludes) your database files.

© 0

Step 3. For the Exclude Directories property, select the following files and delete them using the
remove icon (@) ): file: history and file:"alarm
This includes (not excludes) alarm and history files.

Backing up by creating a distribution file

This procedure backs up a Supervisor and any subordinate stations. Creating a single distribution (.dist) file is
the most complete way to back up a Supervisor station and its subordinate remote stations. The backup file
includes all station data and module-dependency information.

Prerequisites:

Your PC is connected to the network with any remote controller subordinate stations. You are using a browser
(the web Ul) to connect to the Supervisor station.

Step 1. Open a browser and log in to the AX Supervisor station that you want to back up.

Step 2. From the Home view, click System Setup > Backups.

The Backups view opens.

Step 3. Click the System Backup button.

80
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Step 4.

Step 5.
Step 6.

Step 7.

Step 8.

The System Backup window opens with two option boxes selected.

systemBackup.label

#| Archive Backup on Supervisor
#| Download Backup

0Ok | Cancel

Selecting the first option (check box) enables a backup of the Supervisor station and all its
subordinate stations. The second option (check box), when selected, automatically downloads the
backup to your local Downloads folder.

To continue, click Ok.
The Job window displays a progress bar while the backup job runs. When the job finishes, another
Local Backup window opens with a “Show Details” link and a Download button.

To display the history of this backup job, click the Show Details link.

To save the backup *.dist file to a designated location, click the Download button. In this case, the
browser saves the file to the temporary folder and prompts you to open or save the file.
NOTE: You must save the file within five minutes of creating it or it is not available.

Give the file a short name that identifies the Supervisor and subordinate stations, and save the file
to a location other than the System Home or User Home.

Finally, make a note of the date and where you saved the downloaded file for reference when
migrating the file.

Migrating each station

The migrator is a command line utility. Using the backup .dist file, it creates the Niagara 4 Supervisor and
subordinate station folders. Then, using Workbench, you open a platform connection to each new platform and
install each new station using the Station Copier.

Prerequisites:
Niagara 4 is installed on your PC. You know the name of the .dist file and where it is located. Zip files must be
“unzipped” to expose the “*.dist” file for the migrator to process.

Step 1.

Step 2.

Step 3.

Step 4.

Open a standalone Console window using the shortcut from the Windows Start menu.

NOTE: Do not use the Workbench embedded Console. It cannot accept the required keyboard
inputs during the migration process.

Change directories to the location of the backup .dist file.

NOTE: If you change directories to the location of the backup .dist file you do not need to specify
the path to this file.

Enter: ndmig distributionfilename.dist, where distributionfilename.dist isthe
name of the backup .dist file you created.

If the current directory does not contain the .dist file, include the correct file path in the
command line to precede the .dist file name. For example: c: \path\
distributionfilename.dist.

When the process pauses, respond to the prompts in the console window, as follows:
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a. Please select a migration template: 1: Controller Migration Template
or 2: Supervisor Migration Template

b. Enter the passphrase used to protect Niagara 4 BOG files.

If you know the passphrase of the system that you are targeting with the migrated
station(s), enter it here. If you do not know or have access to the system passphrase, create
one now and remember it. You will have to enter it when you copy the migrated station to
the Niagara 4 host system. For more details about passphrase refer to the Niagara Platform
Guide topics: “System Passphrase” and “System passphrase usage in backups and station
copies”.

While the migration utility runs, it displays the log in the console window. The final message

displays the source, target, and Migration Report locations for reference, as shown below:

Completed Migration
Source: backup_EntSec24Supervisor_190411_1415.dist
Target: C:\Users\User123\Niagara4.8\brand\stations\EntSec24Supervisor
Migration Report: C:\Users\User123\Niagara4.8\brand\stations\
backup_EntSec24Supervisor_190411_1415.dist_miglog_190411_1423.html

Step 5. Make a note of these locations.

Copying the migrated files
The migrator places all migrated files in the same location. You need to copy these files to the proper location
for installation.

Prerequisites:
The migrator ran successfully. You have installed Niagara 4 on your PC.

Step 1. Using the operating system’s File Explorer, copy the new, migrated, stations to the user home/
Niagara 4.x/brand/stations directory.

» ThisPC » OS5Disk (C:) » Users » MyName » Miagarad.® » AcmeOZ » stations

Step 2. Launch the Workbench and make a platform connection to the Supervisor station.

Step 3. Do one of the following:

e If the PC you are using also runs the Supervisor station, use Station Copier to copy
Supervisor station from the user_home to the ProgramData directory.

* If the Supervisor station runs on a separate PC, export the tables from the My SQL or SQL
Server database and copy the ProgramData directory with the exported tables to the other
PC.

Setting up the Supervisor’s database password

When you upgrade a Supervisor station from AX to N4, the migrator preserves the password for the
Supervisor's third-party database (MySQL, Oracle, MS SqlServer).

Prerequisites:
The third-party database exists in the Supervisor station.

If no database exists in the Supervisor station, create the new database schema and import to the new schema
the database tables that you previously exported.

Step 1. Using a browser (web Ul), make a connection to the station.
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Step 2.

Step 3.

Step 4.

Step 5.

Click System Setup > Miscellaneous > Configure Database.
The Configure Database view opens to the Database Services tab.

Select the Database tab, for example, MySQLDatabase or SqlServerDatabase.
The selected database (MySQLDatabase or SqlServerDatabase.) tab opens.

T SO | AL Threat Levels

&g Personnel

#3 Home

[ Schedules

dd” Monitoring

#¥% Access Setup &F Intrusion

BE= Backups #¥ Remote Devices

& User Management

Configure Database

H save || & Manage Databases B> Set Orion Database | E@ Restart Station

Database Services MySQLDatabase

Status [{ok} |
Enabled
Fault Cause | |
Health Ok [27-Jun-22 5:09 PM EDT]
Alarm Source Info alarm Source Info »

|ip:|oca|host |
Host Address B
User Name [MySQLUserName |
Password [seessees
Database Name | myentsec |

port
Extra Connection Properties| |
Max Active Connections
Peak Active Connections D
Active Connections D

Confirm that:

® Enabledis set to true.

* Host Address is localhost (for the Supervisor station).
* User Name is correct for the password.

e Database Name matches the name of the database.

To change the Password type a new, strong password and click Save.

The password must contain a minimum of 10 alphanumeric-only characters along with these
special characters: @ # ! $ & + > <] [) (. The password strength check requires at least: 1 digit, 1
upper case character and 1 lower case character.

After making any database change, the framework restarts the station. After the station restarts,
the database should connect using the new credentials, providing data communication from the
newly-connected database.

If Status is {down} and Fault Cause reports that Workbench cannot find the connector even though a connector
isinthe C:\Niagara\Niagara-home\jre\lib\ext folder, make sure that the connector you are using is
compatible with the MySQL software version. For example, version 5 connector will not work with MySQL

version 8.
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The User Name to define on the MySQLDatabase tab is the database User Name, not your station's User

name.

Creating and updating the HSQL database password

Each controller ships from the factory with a default HSQL database password and upgrading an AX station to
an N4 station resets the HSQL database password back to the factory default. While the default password

initially works, as soon as you install or upgrade a controller and its software, you should change this password
to a unique and strong string. The password is automatically generated and successfully stored in the key ring.

Prerequisites:

You have just installed a new controller or upgraded an existing controller from AX to N4. You are using
Workbench running on a PC that is connected to the network that services the controller.

Step 1.
Step 2.

Step 3.
ping results.

(Station_811)
+ Nav

O

@ My Metwaork

(=] (Station_811)
@ Platform
# Station (Station_811)
‘ Alarm
e Config
@ Services
e Drivers
B Miagaraetwork
ﬁ BacnetNetwork
ﬁ HzglDbDatabase
@ SurveillanceViewer
Apps
a Logic
Q Files
@ History

~ Palette

. Station (Station_811)

Connect to the controller station using Workbench.

Expand Config > Drivers > RdbmsNetwork.

. Config . Drivers

Display Name
[J Status
(W Enabled
(W Fault Cause
3 Health
©Q Alarm Source Info
[l User Name
& Worker
™ Export Mode
[ Use Unicode Encoding Scheme
(M Timestamp Storage
@ Points
(@ Sql Scheme Enabled
9, Rdb Security Settings
@ Base Directory
[J Database Name
@ Defrag On Save

@ Defrag And Save Periodic Schedule

. HezglDbDatabaze

Right-click HsqlDbDatabase and click Actions > Ping. The health property is updated based on the

/ ‘Property Sheet -

O Actions & Topics @ Slot Details
Value Commands
{ok]

true .

Fail [null]

Alarm Source Info

Rdbms Worker
By Historyld  +
@ alse

Dialect Default v

Rdbms Point Device Ext
@ false
Rdb Security Settings

file:**hsqldb » #

@ false

30 days {Sun}

NOTE: Starting in Niagara 4.14, the HsglDbDatabase component properties Use Encrypted
Connection, User Name, and Password are replaced with a single Privileged Username
property. The HSQL database is automatically generated and not editable or visible. When using
HSQL, if the station keyring is corrupted, you need to load a backup station, as this instance of
the HSQL database is no longer operational.

Step 4. To access a new HSSQL database instance in the N4 station, right-click the HsglDbDatabase,

84

Step 5.

navigate to Views > Property Sheet.
The device’s Property Sheet opens.

Enter the User Name as SA and click Save.
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Step 6. Right-click HsglDbDatabase and click Actions > Ping. The health property is updated based on the
ping results.

Configuring network device passwords

The devices on the station network may require password reentry in the migrated stations. For example, a
camera or DVR may have a unique device password that needs to be re-entered because it was cleared during
migration process.

Prerequisites:
Your PC is connected to the network with the remote controllers.

Step 1. From a browser (web Ul), make a connection to the remote controller station.

Step 2. Navigate to the Remote Drivers view (Controller Setup > Remote Devices > Remote Drivers).

NOTE: The following steps can be for any network device that requires a password. The steps
below show an example for a video camera device.

E{a Schedules & UserManagement E= Backups =z’ Remote Devices

Remote Drivers

(& ][x][=slle] [F][D][E]
= ]

‘EIT:?] Accesshetwork
ZH PhotoIDNetwork

Step 3. For each network driver that may require a password, select the driver, click the Hyperlink button (
@!) on the menu and navigate to the device in the network (for example a Camera).
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% Schedules 2 User Management

8= Backups | ¥ Remote Devices

%% Axis Video Network (naxisVideo:AxisVideoNetwork)

{3 Status

i Enabled

i) Fault Cause
Health

£ Alarm Source Info
B monitor

% Tuning Polides
i) Fox Video Stream Preferred
g< Pol

&P Http Config

{3} Event Receiver

) Discovery Preferences

B |AosVideoCamera

{ok}

|

Ok [10-Apr-19 4:31 PM EDT]

Alarm Source Info

Ping Maonitar **

Default Policy Tuning Policy *

N Poll Scheduler

Http Comm Config

Axis Video Events Receiver

Axis Camera Discovery Preferences
Axds Video Camera

The screen capture shows this link for an Axis camera.

Step 4. Tadisplay and update the device properties, click the device link.

Step 5. Ubdate the device password and click Save
The device password is updated.

Deleting the old certificates

Niagara AX to N4 Migration Guide

To promote secure communication in Niagara 4 it is recommended that you install new TLS certificates. This
procedure deletes the old certificates. Perform these steps for each station, Supervisor and all remote stations.

Prerequisites:

You are using the Supervisor PC running Workbench. All stations are idle.

NOTE: Subsequent procedures assume that this installation uses default self-signed certificates. If the
company uses signed certificates (the most secure configuration), you will need to create a new root CA
certificate, create a new server certificate for each platform/station, use the root CA certificate to sign each
server certificate and install each signed server certificate after completing the migration.

While you may delete certificates using the browser (web Ul), this procedure manages all certificate processes

using Workbench.

Step 1. Open a platform connection to the Supervisor PC or remote controller (File > Open > Open

Platform.

Step 2. Expand the Platform node and double-click Certificate Management in the Nav tree.

86
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-

- Nav Certificate Management
O @ My Netw Certificate Management for "172.31.66.19"
& Platform User Key Store  System Trust Store  User Trust Store  Allowed Hosts

@ Application Director

- You have local certificates:
0 Certificate Management

@ Distribution File Installer User Key Store 1 objects
@ File Transfer Client .

Alias Subject Mot After Key Algorithm  Key Size  Valid B
O Lexicon Installer

X tridium  NiagaraA¥ Thu May 16 14:4%:16 EDT 2019 RSA 1024 true
@ License Manager
e Platform Administration
View | New | Cert Request | Delete

O Software Manager @ @ = @
€ station Copier @ Import | @ Export | X Reset |

Step 3. Inthe User Key Store, select the certificate, click Delete (as shown above) and click Yesto confirm
the deletion.

Step 4. Select the Allowed Hosts tab, select an allowed self-signed certificate, click Delete and click Yes to
confirm the deletion.
This action deletes the certificate.

Step 5. Restart the station.

Step 6. Perform these steps in the Supervisor and each remote station.

Reconnecting the Supervisor and remote stations

This procedure reconnects the remote stations to the Supervisor station.

Prerequisites:
You have deleted all old AX certificates from all stations.

Step 1. Using the web Ul, make a connection to the Supervisor station and accept the self-signed
certificate.

Step 2. Click System Setup > Remote Devices > Station Manager.
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Step 3.

Step 4.
Step 5.

Step 6.

The Edit window opens.
The following properties configure the connection

from the local station to the remote Stattiﬁ"
(Username/Password must already exist on the remote station):

Station Name  |entSecurity602

Enabled

Address 172.31.66.19 |

| UsermamefndPassword s |

Credential Store Username |admin |

Password [sessssss |

Use Foxs
Fox Por

| Continue to Remote Configuration...

|(an0|:||

To re-establish the connection between the Supervisor and each subordinate station, enter the

remote station credentials.

Approve each station’s self-signed certificate.

For each subordinate station, do a Join, as described in “Joining a controller station to the

Supervisor station” in the Niagara Enterprise Security Installation and Maintenance Guide

To set up data in each remote station, do a Replicate, as described in the “Replicating a
configuration” topic in the Niagara Enterprise Security Installation and Maintenance Guide.

Restoring the BackupService schedules

This procedure describes how to restore the BackupService schedules.

Prerequisites:
You are connected to the Supervisor station using a browser (the web Ul).

Step 1. Click System Setup > Backups.
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The Backups view opens.

Home &a” Monitoring &g Personnel Reports #% System Setup

E Schedules & User Management | = Backups #¥ Remote Devices ¥

IH save systemBackup.label localBackup.label | &1 Restore

Backup Archive Backup Schedule Recent Backup History

o o

E@. file:~backups/backup_entsec_190409_2147.zip

Step 2. Click the Backup Schedule tab.
The Backup Schedule view appears.

[ Schedules & UserManagement A= Backups #F¥ Remote Devices

#% Access ref c "

= save systemBackup.label localBackup.label || ER Restore

Backup Archive Backup Schedule Recent Backup History C] L

System Backup Schedule [ |none [ » —— —
Local Backup Schedule 7] |None » nays P
Scheduled System Backup Limit |10 [1 - +inf] M-F: 65 fok}
Scheduled Local Backup Limit 10 [1 - +inf]
Alarm Info Alarm Source Info »

Step 3. To select the backup schedule, click the Ref Chooser chevron (>>)
The Ref Chooser window opens.

Step 4. To assign a schedule to the backup, select the desired schedule from the table and click Ok.

H save systemBackup.label localBackup.label | £ Restore
Backup Archive Backup Schedule Recent Backup History
System Backup Schedule JllAlwavs [Access] » RO
Local Backup Schedule | |None »
Scheduled System Backup Limit 10 [1 - +inf]
Scheduled Local Backup Limit 10 [1 - +inf]
Alarm Info Alarm Source Info »
Next steps
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Repeat this procedure for all the migrated stations.
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Chapter 5. Connecting a Supervisor
station to a legacy controller station

Niagara Enterprise Security connections from Niagara 4- based stations to NiagaraAX (JACE-6 controller)
stations were not possible before the release of Niagara 4.8. With Niagara Enterprise Security 4.8, stations can
now connect and join to Niagara Enterprise Security 2.3 JACE-6 controllers by following the instructions
included in this document.

The goal of this process is to have the Niagara Enterprise Security N4Supervisor connect, join, and replicate
with a subordinate JACE-6 controller that is running Niagara Enterprise Security 2.3. After you complete this
procedure, the remote controller is connected and communicating with the Supervisor station as a
subordinate. With this relationship and communication established, you can join and replicate using the same
procedures that describe those tasks for JACE-8000 and JACE-9000 security controllers. Refer to Station join
best practices and Joining a controller station to the Supervisor station topics for details. Also, refer to Wire
compatibility for details about communication and feature support between the two versions of Niagara.

To establish communication (connect) between the Niagara Enterprise Security 4.8 Supervisor station and a
legacy NiagaraAX JACE-6 controller station, you need to use both Workbench and a browser to configure the
following:

1. Prepare the Niagara Enterprise Security 4.8 Supervisor station (add a user, configure WebService and
FoxService).

2. Discover and add the remote NiagaraAX controller station to the Supervisor station database.

3. Establish an authenticated user connection from the remote NiagaraAX controller station to the Niagara
Enterprise Security 4.8 Supervisor station.

4. Create the proper Supervisor — subordinate relationship between the two controller stations.

Each of these procedures are detailed in specific tasks that follow.

1. Configuring the Niagara Enterprise Security 4.8 Supervisor station
connection

This procedure describes how to setup the Niagara Enterprise Security 4.8 station so that a legacy JACE-6
controller (running a station with NiagaraAX-3.8) can connect and authenticate a user with the newer station.

Prerequisites:
Niagara Enterprise Security 4.8 Workbench application is installed and running.

Step 1. Using Niagara Enterprise Security 4.8 Workbench, connect to the security Supervisor station that
will establish a connection with the legacy controller.

Step 2. In the Supervisor station, navigate to Config > Services and double-click on the UserService node.
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Step 3.

Step 4.

Step 5.

The User Manager view opens.

Niagara AX to N4 Migration Guide

44 Edit
MName Full Name Enabled Expiration Roles
a UserAX AXController true Mever
F. Name Userhd

F. Full Name A¥ Controller

l.l true
Mewer Expires
® p

J admin

(gl Enabled
F. Expiration

Badge Operato

F. Auto Logoff Settings

admin,defaultPrototype  true

s/ defaultPrototype

F. Roles _ >>
Maintenance
Cperator
Personnel Management
F. Allow Concurrent Sessions l.l true
Auto Logoff Enabled . true

Use Default Auto Logoff Period . true

Allow Concurrer

> ExpiresOn |04-Rpr-201% 11:5!

r

Auto Logoff Period 00000h 15m
F. Network User l. false
F. Prototype Name
F. Language IE
F. Authentication Scheme Name |4¥[DigestScheme

Password ssesssse

Confirm esssssess
F. Authenticator

Farce Reset At Next | aein | false

oK | Cancel |

In this view, create a new user that you will use later to authenticate the NiagaraAX controller

station connection back to this Supervisor station.

Name the User and set the property values including these two properties:

¢ For Authentication Scheme Name, choose: AX digest scheme.

¢ For Roles, choose: admin.

Navigate to Config > Services > WebService.

March 12, 2025



Niagara AX to N4 Migration Guide Connecting a Supervisor station to a legacy controller station

The WebService Property Sheet opens.

Property Sheet

© webservice (Web Service)
li Status {0k}
[ Fault Cause

(@l Enabled @ e

(@ Http Port 81 tcp

(@l Http Enabled ® e
(@l Https Port 444 tcp
(@l Https Enabled ® true
[ Https Only O ke
[l Https Min Protocol TLSw1.0+
(@ Cipher Suite Group Supported

Pl sias_ -~

Step 6. Set the Cipher Suite Group property value to the Supported option and click Save.

Step 7. Navigate to Config > Services > FoxService.
The FoxService Property Sheet opens.

Property Sheet
¥ FoxService (Fox Service)
(W FoxPort 1911 tep
(Ml FoxEnabled @ e
Foxs Port 4911 tcp
% Foxs Enabled @ e
(Ml Foxs Only O false
(@l Foxs Min Protocol TLEw 1.0+
(M Cipher Suite Group 'Supported |~ |
[i Foxs Cert tridium

Step 8. Set Cipher Suite Groupto the Supported option and click Save.

Step 9. Navigate to the Supervisor Certificate Management view (Platform > Certificate Management)
and delete the remote controller certificate from the Allowed Hosts table.
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'=' My Host: VAS1LTDIHCTQ2.globa

e My File System

G My Modules

&= My Tools

&r Platform
@ Application Director
G Certificate Managemeni
{i Lexicon Installer
@ License Manager
) Platform Administratiol

Niagara AX to N4 Migration Guide

User Key Store  System Trust Store  User Trust Store
Hosts and host certificates that could not be validated:

Allowed Hosts

Host Subject Approval Created

172.31.66.19:4911 MiagaraAX

View

5 172.31.66.19:5011 NiagaraAX
Unapprove
Delete
R

Step10. Within N4 Workbench, open a platform connection to your AX controller.
While you cannot connect to an AX station from N4, you can connect to the platform.

Step11. Navigate to the remote controller Certificate Management view (Platform > Certificate
Management) and delete the Supervisor certificate from the Allowed Hosts table.

- Nav

O

172.31.66.10 (entSecurity801)

@ My Network

172.31.66.20
@ 172.31.66.19
T Platform
@ Application Director
0 Certificate Managemeni
@' Distribution File Installe
@ File Transfer Client

Certificate Management

Certificate Management for "172.31.66.19"

Uszer Key Store  System Trust Store  User Trust Store  Allowed Hosts
Hosts and host certificates that could not be validated:

Allowed Hosts

Host Subject  Approval Created lssued By

localhost:4911  MiagaraAX

r04 11:00:39 EDT 2019 MiagaraAX

% Approve

View

Unapprove

Delete
=

2. Adding a remote controller 2.3 station

Use this procedure to initiate the connection between Niagara Enterprise Security 4.8 stations and AX-3.8
stations. Authentication fails on the initial attempt to connect but may complete in a subsequent procedure.

Prerequisites:

The Supervisor station is configured to accept the NiagaraAX-3.8 user connection.

Step 1. Using the browser of your choice and the Java web launcher app, open a station connection to
your Supervisor and controller stations using the user with admin rights.

Step 2. To find the AX Stations to connect to from the N4 Supervisor, navigate to Remote Devices and run

a discovery job.

94
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Step 3.

Step 4.

Step 5.

Step 6.

Step 7.

The station appears in the Discovered pane.

NOTE: If discovery does not find the station, manually add the station (click the Add button, and
provide the AX controller’s IP address and credentials).

Select the station to add and click the add (+) button.
The Add Station(s) window opens.

sy

The follewing properties configure the connection The followiing properties configure the connection
from the local station to the remote station from the remote station back to the local station
(Username/Password must already exist on the remote station): (Username/Password must already exist on the local station):
Enabled true v Enabled true ¥
UsernameAndPassword ¥ UsemameAndPasswiord ¥
Credential Store Username admin Credential Store Username User1234
Password [seesnenens ] Password 2200 I |
Use Foxs true ¥ Use Foxs true ¥
Fox Port 4911 _ Fox Port 4911 | &
What is the role of the remote station from the perspective of the local station?
Desired Role  Subordinate v
Ok | Cancel

Starting with the left side of the window, enter the Username and Password for Supervisor to login
to the remote station (these credentials must already exist on the remote controller).

On the right side of the window, enter the Username and Password for the newly created user so
that the remote AX-3.8 controller can log in to the Supervisor (these credentials must already exist
on the Supervisor).

Make sure that the Desired Role property is set to Subordinate and click Ok.
The Supervisor runs the add-station job and adds the remote station to the Supervisor database.

NOTE:

An Authentication Failure message displays at the completion of the job. This is because
of the different credential storage capabilities in the two different versions. The following steps
provide a way to resolve this from the remote controller and complete the connection.

Home || & Monitoring | | &2 Personnel #¥ System Setup nlaga ra

IraMmEWDrk

@ Schedules & UserManagement A= Backups &% Remote Devices #¥ Access Setup  #F Intrusion Setup &% Alarm Setup &% Miscellaneous

ADEnerEE LeEEER
Station Name / Host Name Scheme Fox Port Status Actual Role Role Status
entSecuritys02 172.31.66.19 foxs 4911 {ok} Peer {fault} [entSecurity602]: SysDef extension not in a valid state to change roles: {down}
Discovered
2l
Station Name Host Name Scheme Fox Port Already Exists

Navigate to System Setup > Remote Devices > Certificate Management and approve the remote
controller certificate.
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3. Logging in to the Supervisor from the controller

These steps connect from the NiagaraAX-3.8 legacy security station to the security Supervisor and
authenticate the connection using the newly-created credentials for a user with AXDigestScheme
authentication.

Prerequisites:
The record for the remote legacy controller is added to the Niagara Enterprise Security 4.8 Supervisor station
database.

Step 1. Inthe browser, connect to the remote NiagaraAX controller: from the main menu, select
Controller Setup > Remote Devices and click on the Certificate Management view, approve the
Supervisor certificate.

Step 2. From the main menu, select Controller Setup > Remote Devices and click on Station Manager to
display the Station Manager Database view.
The Supervisor station displays as a row in the table view.

&d" Monitoring & Personnel #+* Controller Setup

niag

E= Backups & Remote Devices @ #' Access Setup £ Intrusion Setup 3% Alarm Setup 4% Miscell

% Schedules 2 User Management

Station Manager - Database

LIEIEIE]E]G]

Station Name & Host Name

137.19.60.123

Step 3. Select the Supervisor station and click the Edit icon ([&])-
The Edit window opens.

The following properties configure the connection
from the local station to the remote station
{Username/Password must already exist on the remote station):

Station Name | EntSec24Supenvisor |

Enabled

Address [111.22.33.444 |
Username | Userfl |
Password ||---|--| |

use Foxs
Fox Port 40911

I Continue to Remote Configuration... | | Cancel

Step 4. Enter credentials for the newly created NiagaraAX user, verify that the other properties are
correct for the connection and click Continue to Remote Configuration.
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Step 5.

4. Connecting from the Supervisor to the NiagaraAX-3.8 legacy security

station

The following task describes how to connect from a configured legacy controller station (running
NiagaraAX-3.8) to a properly configured Niagara Enterprise Security 2.4 Supervisor.

The connection to the remote station (Supervisor) continues and the Remote Configuration

window appears.

The folowing praperties configune the conpection
fromthe remote station back to the local station

(Usemame/Password must already exist onthe ol station):

Enabled

username | |

Password |ssssssss
Use Foxs 'Iad-se V'_
Fox Port .1‘J11

Whatis the rde of the remobe station from the perspective of the local station?
Desired Role | Peer ol
ok || cancel

Click Cancel in the Remote Configuration window.

The system closes the window. To authenticate the connection, you must complete the process

with the following task.

Prerequisites:

The legacy controller station has completed a user login to the Niagara Enterprise Security 2.4 Supervisor

station.

Step 1.

Step 2.

In the browser, connect to the Supervisor and navigate to the station database view (System

Setup > Remote Devices > Station Management)

Connecting a Supervisor station to a legacy controller station

Select the remote NiagaraAX-3.8 legacy security station and click the Edit icon ( ). These fields

should already be populated. Verify the fields and click Continue to Remote Configuration.
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The Remote Configuration window opens.

The following properties configure the connection
from the remote station back to the local station
{Username/Password must already exist on the local station):

Enabled | trus *

Cd credentialStore Username Userdx

UsernameAndPassword ¥

Niagara AX to N4 Migration Guide

Password |llllllllllll|

Use Foxs trus ¥
Fox Port 4911

Desired Role | Subordinate ¥

ok | Cancel

What is the role of the remote station from the perspective of the local station?

Step 3. Enter the newly created user credentials and click Ok.

The Remote Configuration window closes, the configure job runs and establishes the connection
with the correct relationship between Supervisor and subordinate. You are ready to proceed with

station Join and Replicate procedures.

Result

Once the Niagara Enterprise Security 4.8 Supervisor station connects to the NiagaraAX-3.8 legacy station, no
further migration of the legacy station is required. The legacy station cannot be migrated to Niagara
Enterprise Security 4.8 until the JACE-6 is replaced with newer hardware.
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Chapter 6. Migration reference

A number of changes to NiagaraAX Program objects (components) need to be made to allow them to run
under Niagara 4. The N4 migration tool can make some of these changes for Programs as part of the station
migration process.

However, other changes often require post-migration work on certain Programs in the (offline) migrated
station.

Imports

The first step in converting Program objects to run under Niagara 4 is to update imports to declare
dependencies on the appropriate runtime profile JAR files. In most cases, this will be the rt runtime profile JAR
file for the module (baja and nre do not have a runtime profile extension).

If your Program object was run through the N4 migration tool as part of a station migration, this change will
have been made for you.

APl changes

If your Program objects use certain APls that have had breaking changes, they will need to have their Program
code updated and recompiled using the new Niagara APIs.

Most notable are the “Collection API/Cursor”, “Alarm API", “History API", and “Logging API”. For more
information on these changes and how to update your code, see the Niagara Developer Guide for each of
these APl changes.

Also, note getProgram() was deprecated starting in EC-NetAX-3.5 in order to support compiling Programs into

Program Modules. It has been removed for N4.0. While in the past, Program objects using this method would
still compile and run, they now require conversion to use getComponent() instead.

Primitives
Slots that are defined as baja:Boolean, baja:Double, baja:Float, baja:Integer, baja:Long and baja:String now
return their Java primitive types.

This means that you no longer need to call getBoolean(), getDouble(), getFloat(), getint(), getLong() or
getString() to cast the values of these slots to primitive values.

For example, for a slot defined on a Program as: Name=temperature, Type=baja:Double
NiagaraAX Program object:

double temp = getTemperature().getDouble();

Niagara 4 Program object:

double temp = getTemperature();

Security Manager

Niagara 4 utilizes the Java Security Manager, which puts restrictions on what Program objects may do.
Program objects interacting with the station’s component tree should be largely unaffected by the Security
Manager.
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File reading/writing

A restriction has been put on file reading and writing to only allow read-from and write-to the station_home
directory (file: 7).

Runtime.exec()

The ability to call external executables is extremely useful in certain situations, however the use of
Runtime.exec() can allow potentially malicious code to be executed. As such, several restrictions are placed on
it to help protect your system.

Only station super users can add and edit Program objects. In NiagaraAX, there was a flag/entry to change this
behavior in system.properties. In Niagara 4, this ability has been removed.

Program objects can no longer directly call Runtime.getRuntime().exec(command). Instead, a wrapper called
ProgramRuntime behaves the same way as java.lang.Runtime, except that it takes the Program object as an
additional parameter. Commands executed by ProgramRuntime are logged and audited.

Additionally, to enable the use of ProgramRuntime, the hidden slot allowProgramRuntimeExec on the station’s
ProgramService must be set to true.

NOTE: Only standalone Program objects can use ProgramRuntime.exec(). Program objects that have been
compiled into Program Modules cannot call this function.

An example of this in Program code is below
NiagaraAX Program object:
Runtime.getRuntime().exec(”notepad.exe”);
Niagara 4 Program object:

ProgramRuntime.getRuntime().exec(this, “notepad.exe”);

Example Program object fix

The following is a simple example fix for a Program object included in the widely-distributed NiagaraAX demo
station. It is one of several Programs flagged with a “WARNING unable to compile” entry when AX-3.8 station
backup .dist file for the demo station is used as source in the N4 migration tool.

A related snippet from the migration report (log file) looks like below.

WARNING unable to compile Program object PxHome.Graphics.Residential.First Floor.
GarageProgram
C:\Users\e333988\Niagara4.x\temp\Prog_ea44c5d3b904631ea44c5d3b904631.java:40: error:
cannot find symbol
Action action = getProgram().getAction("execute");
N
symbol: method getProgram()
location: class Prog_ea44c5d3b904631ea44c5d3b904631

This error relates to use of getProgram(), as described in APl changes.

Opening the migrated “demo” station in your N4 EC-Net 4 Pro, you can follow the ORD given in the warning,
and open the Program Editor view for that Program (“GarageProgram”), as shown in the following figure.
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Figure 23. Example Program with issues from migrated “demo” station

o] 73 a ) EllE

T
") Program is out-of-date and requires compile.

r_'i?, EditTE SIotsTQ ImportsT@ Sour::e-]

public void onStart() throws Exception

1
L

public void onExecute() throws Exception

f
double rnd = (Math.random()-.5)/1000;

if (getDoorOpen() .getValue())
{
getlut () . 3etValue ( (getlut () .getValue () +getlutside () .getDouble () *2) /34rnd)
1 else |
}
1
)

public wvoid onStop() throws Exception

ticket.cancel();

1
I

private Clock.Ticket ticket:|

The WARNING snippet resulted from use of the now-obsolete getProgram(), which must be replaced by

getComponent(). Also note the Program status: “Program is out of date and requires compile.”

{
Action action™= .gEtAc:tic:n-j "execute™) ;
ticket = Clock.schedule Erlu::iiu:allj;-jthis., ERelTime.makeSeconds (10}, action, null);

getlut () .setValue ( (getlut () .getValue () *34 (getSetpoint () .getValue () +getfutside () .getDoukle () ) /2) /10+nd) ;

If you compile the Program now without making any changes, various errors (4) appear in the console area at

the bottom of the EC-Net 4 Pro window, as shown below.
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Figure 24. Example errors from a compile before making any Program changes

private Clock.Ticket ticket;

4 ¥ 4 L3

C:\Users\e333988\Niagara4.0>"C:\Niagara'\Niagara-4.0.10.2 \Jre\bin\Javac”™ -encoding UTF-8 -profile compactd -EKlint:dd
Frog 84d5c47clie54e0d84d5c4Tcli654eld. java:40: error: canneot find symbel
Leotion action = getProgram{) .gethcotion("execute™):
symbol: method getProgramf()
location: class Prog B84d5c47cl3654e0484d5c47c19654e0d
Prog_84d5c47cl9654e0d84d5c47c19654e0d. java:41l: error: cannot find symbol
ticket = Clock.schedulePeriodically{this.getProgram{), BRelTime.makeSeconds (10}, action, null);

symbol: method getProgrami)
Prog_84d5c47cl9654e0d84d5047c19654e0d. java:51: error: double cannot be dereferenced
getiut () .setValue { (getOut () .getValue () +getlutside () .getDouble () *2) /3+rnd) ;
Prog_84d5c47cl9654e0d84d5047c19654e0d. java:53: error: double cannot be dereferenced
getiut () .setValue { (getlut () .getValue () *3+ {getSetpoint {) .getValue () +getlutside () .getDouble () ) /2) /10+rnd) ;

4 errors
C:\Users\e333988\Niagarad. 0> =

After replacing the two getProgram() instances to getComponent(), saving and then recompiling again, errors
are reduced to two—related to use of getDouble() for primitives (Figure28).

Figure 25. Example Program with remaining issues from primitive syntax errors

T
@ Program cannat be compiled.

r,'i? EditTE SIotsTO ImportsT@ Sour::e-]

public woid onStart() throws Exception
{
Action action = getComponent () .gethAction("execute™);

ticket = Clock.schedulePericdically(this.getComponent(), BREellime.makeSeconds (10}
1
I

, action, null);
public woid onExecute (] throws Exception
{

double rnd = (Math.random()-.5)/1000;

if {getDoorOpen() .getValue()) \
{

getlut () .setValue ( (getlut () .getValue () +getlutside ()|.getDouble ()|*2) f3+rnd) ;
]} else {
I
getlut () .setValue ( (getlut () .getValue () *9+(getSetpoint () .getValue () +getlutside (}|.getDouble ()|} /2) /104end) ;

1
I

1
I

public woid onStop() throws Exception
{

ticket.cancel();
1
I

This is no longer necessary, as explained in the section Primitives. To fix, simply remove the text shown marked
above.
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As shown below, now after resaving the Program and recompiling, all errors are gone.

Figure 26. Example Program object after fixing all issues and recompiling.

EE T a3 ) Elr
T
& [ Nav ) Program is up-to-date,
o s
=] E El EditTE SIotsTO ImportsT® Soumq
= -
== MyHost: VA I puklic void onStart() throws Exception
==| My File {
ﬂ Action action = getComponent () .gethction ("execute™);
Sy ticket = Clock.schedulePeriodically(this.getComponent (), BRelTime.makeSeconds(10), action, nullj;
Cus 1
E— public void onExecute() throws Exception
O I
E double rnd = (Math.random()-.5)/1000;
E if (getDoorlpen() .getValue () )
{
E getlut () .setValue ( (getlut () .getValue () +getlutside () *2) /3+rnd) »
} else |
E getlut () .setValue ( (getlut () .getValue () *3+(getSetpoint () .getValue () +getlutside () ) /2) /10+rnd) ;
1
L)
I }
E public void onStop() throws Exception
ticket.cancel();
}
_I_|—|_|L private Clock.Ticket ticket:
4 »
Y
C:\Users\e333988\Niagarad.0>"C:\Niagara\Niagara-4.0.10.2\jre\bin\javac" -encoding UTF-8 -profile compact3 -Klint:depd |
C:\Users\e333988\Niagarad.0> [~ |

Now note the status of the Program is: “Program is up-to-date”, and there are no errors reported in the

bottom console area after the last compile and save.
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